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          Adobe Acrobat Reader  
 

Finding Words 
 

You can use the Find command to find a complete word or part of a word in the current PDF 

document.  Acrobat Reader looks for the word by reading every word on every page in the file, 

including text in form fields. 
 

To find a word using the Find command: 
 

1. Click the Find button (Binoculars), or choose Edit > Find. 

2. Enter the text to find in the text box. 

3. Select search options if necessary: 

Match Whole Word Only finds only occurrences of the complete word you enter in 

the box.  For example, if you search for the word stick, the words tick and sticky will 

not be highlighted. 

 

Match Case finds only words that contain exactly the same capitalization you enter in 

the box. 

 

Find Backwards starts the search from the current page and goes backwards through 

the document. 

4. Click Find.  Acrobat Reader finds the next occurrence of the word. 

        

To find the next occurrence of the word, Do one of the following: 

            

            Choose Edit > Find Again  

            Reopen the find dialog box, and click Find Again.  

            (The word must already be in the Find text box.) 

 

Copying and pasting text and graphics to another application 
 

You can select text or a graphic in a PDF document, copy it to the Clipboard, and paste it 

into another application such as a word processor.  You can also paste text into a PDF 

document note or into a bookmark.  Once the selected text or graphic is on the Clipboard, you 

can switch to another application and paste it into another document.   

 

Note:  If a font copied from a PDF document is not available on the system displaying the 

copied text, the font cannot be preserved.  A default font  is substituted. 
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To select and copy it to the clipboard: 

1. Select the text tool T, and do one of the following: 

       To select a line of text, select the first letter of the sentence or phrase and drag to 

       the last letter.   

 

To select multiple columns of text (horizontally), hold down Ctrl+Alt (Windows) or Option 

(Mac OS) as you drag across the width of the document.  

        

To select a column of text (vertically), Hold down Ctrl+Alt (Windows) or Option+Command 

(Mac OS) as you drag the length of the document. 

         

To  select all the text on the page, choose Edit > Select All.  In single page mode, all the text 

on the current page is selected.  In Continuous or Continuous – facing mode, most of the text 

in the document is selected.  When you release the mouse button, the selected text is 

highlighted.  To deselect the text and start over, click anywhere outside the selected text.   

The Select All command will not select all the text in the document.  A workaround for this 

(Windows) is to use the Edit > Copy command.  Choose Edit > Copy to copy the selected 

text to the clipboard. 

 

2. To view the text, choose Window > Show Clipboard 

 

In Windows 95, the Clipboard Viewer is not installed by default and you cannot use the 

Show Clipboard command until it is installed.  To install the Clipboard Viewer, Choose 

Start > Settings > Control Panel > Add/Remove Programs, and then click the Windows 

Setup tab.  Double-click Accessories, check Clipboard Viewer, and click OK. 
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METROPOLITAN TRANSPORTATION COMMISSION 1 

REGIONAL ADVISORY WORKING GROUP 2 

TUESDAY, JULY 7, 2020, 9:35 AM 3 

 4 

MATT MALONEY: GOOD MORNING EVERYBODY. WELCOME TO THE REGIONAL 5 

ADVISORY WORKING GROUP. IT IS JULY 7TH, 2020. BEFORE WE GET 6 

INTO THE MEAT OF OUR AGENDA TODAY, I HAVE A FEW NOTES TO 7 

ANNOUNCE. DUE TO COVID-19, THIS MEETING WILL BE CONDUCTED AS A 8 

ZOOM WEBINAR. PURSUANT TO THE PROVISIONS OF THE GOVERNOR'S 9 

EXECUTIVE ORDER N-29-20, WHICH SUSPENDS CERTAIN REQUIREMENTS 10 

OF THE BROWN ACT. RAWG IS NOT A BROWN ACT MEETING. THIS 11 

MEETING WILL BE WEBCAST ON THE MTC WEB SITE. I WILL CALL UPON 12 

COMMISSIONERS, PRESENTERS, STAFF, AND OTHER SPEAKERS BY NAME 13 

AND ASK THAT THEY SPEAK CLEARLY AND RESTATE THEIR NAMES BEFORE 14 

GIVING COMMENTS OR REMARKS. PERSONS PARTICIPATING VIA ZOOM AND 15 

WEBCAST WITH THEIR CAMERAS ENABLED ARE REMINDED THEIR 16 

ACTIVITIES ARE VISIBLE TO VIEWERS. COMMISSIONERS AND MEMBERS 17 

OF THE PUBLIC PARTICIPATING BY ZOOM, WISHING TO SPEAK SHOULD 18 

USE THE RAISED HAND FEATURE OR DIAL STAR NINE AND I WILL CALL 19 

UPON YOU AT THE APPROPRIATE TIME. TELECONFERENCE ATTENDEES 20 

WILL BE CALLED UPON BY THE LAST FOUR DIGITS OF THEIR PHONE 21 

NUMBERS. AND IT IS REQUESTED THAT PUBLIC SPEAKERS RESTATE 22 

THEIR NAMES AND ORGANIZATIONS, BUT PROVIDING SUCH INFORMATION 23 

IS VOLUNTARY. MEMBERS OF THE PUBLIC WISHING TO ADDRESS THIS 24 

BODY WERE ASKED TO SUBMIT COMMENTS IN WRITING AT 25 
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INFO@BAYAREAMETRO.GOV. WRITTEN COMMENTS RECEIVED WILL BE 1 

POSTED TO THE ONLINE AGENDA AND ENTERED INTO THE RECORD BUT 2 

WILL NOT BE READ OUT LOUD. IF AUTHORS OF THE WRITTEN 3 

CORRESPONDENCE WOULD LIKE TO SPEAK, THEY ARE FREE TO DO ON THE 4 

REFERENCED AGENDA ITEM OR ANY TOPIC THEY CHOOSE. WITH NO 5 

FURTHER ADO, LET'S GET INTO THE AGENDA TODAY. WE HAVE A LOT TO 6 

COVER. A MAJOR MILESTONE TODAY WITH THE RELEASE OF THE DRAFT 7 

BLUEPRINT OF PLANNED BAY AREA 2050. I WILL TURN IT OVER TO 8 

DAVE VAUTIN WHO WILL RUN THROUGH THAT PRESENTATION FOR YOU. 9 

>DAVE VAUTIN: GOOD MORNING EVERYBODY. DAVE VAUTIN, PLANNED BAY 10 

AREA 2050 PROJECT MANAGER. THANK YOU FOR JOINING US FOR THIS 11 

MORNING'S REGIONAL ADVISORY WORKING GROUP. AS MATT JUST SAID, 12 

WE DO HAVE A REALLY PACKED AGENDA THIS MORNING WITH A LOT TO 13 

TALK ABOUT. WE'RE EXCITED TO SHARE WITH THE ANALYSIS OF THE 14 

DRAFT BLUEPRINT, WHICH WAS APPROVED PER STUDY BY THE MTC AND 15 

ABAG BOARDS IN FEBRUARY. SO WE'RE GOING TO START OFF WITH THAT 16 

TODAY. DRAFT BLUEPRINT ANALYSIS, WHICH WE RELEASED EARLIER 17 

THIS WEEK IS REALLY A CULMINATION OF THE DRAFT BLUEPRINT PHASE 18 

WHICH IS A ROUGH DRAFT FOR PLANNED BAY AREA 2050, AND AN 19 

OPPORTUNITY FOR INPUT AND REFINEMENT AT THIS CRITICAL POINT. A 20 

REFLECT OF A JOINT WORK OF A VARIETY OF TEAMS ACROSS MTC AND 21 

ABAG AND I WANT TO ACKNOWLEDGE ALL THAT WORK THAT HAS BEEN 22 

DONE UNDER THESE VERY DIFFICULT CIRCUMSTANCES IN THE PAST FEW 23 

MONTHS. YOU WILL ALSO HEAR TODAY A PIVOT OF TWO PRESENTATIONS, 24 

ONE ON THE DISCRETIONARY COMMITMENT ON SOME OF OUR MAJOR 25 
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TRANSPORTATION PROJECTS AND ANOTHER ON ADDITIONAL PRIORITY 1 

DEVELOPMENT AREAS WHICH WE WILL BE WEAVING INTO THE FINAL 2 

BLUEPRINT. A LOT TO TALK ABOUT AND A LOT TO COVER WITH THE 3 

FINAL BLUEPRINT REVISIONS THIS SUMMER. WE'LL NOTE THAT THE 4 

FINAL BLUEPRINT PHASE WILL BE BEGINNING AND WE'LL BE TAKING 5 

KEY ACTIONS ON THAT TO OUR BOARD IN SEPTEMBER, THAT'S THE 6 

CURRENT TARGET. I'M GOING TO ASK THE BROADCAST TEAM TO LOAD UP 7 

THE SLIDE DECK AT THIS POINT. WE'LL GO TO THE NEXT SLIDE HERE. 8 

SO, SPEAKING OF THE TIME FRAME, THIS GRAPHIC WHICH WE HAVE 9 

SHOWN A NUMBER OF TIMES, HIGHLIGHTS A CRITICAL JUNCTURE. NEXT 10 

SLIDE. IT'S REFLECTS A CRITICAL JUNCTURE WITH THE COMPLETION 11 

OF THE DRAFT BLUEPRINT. AFTER TWO YEARS OF WORK ON THE 12 

PREDECESSOR HORIZON INITIATIVE FOLLOWED BY ROBUST STAKEHOLDER 13 

ENGAGEMENT THIS FALL AND WINTER TO REFINE AND CRAFT OUR 14 

STRATEGIES FOR THE DRAFT BLUEPRINT WE HAVE COMPLETED MODELING 15 

AND ANALYSIS WORK FOR THE DRAFT BLUEPRINT. THIS IS A MAJOR 16 

MILESTONE FOR PLANNED BAY AREA 2050 THE PRESENTATION WILL BE A 17 

LITTLE LONGER THAN NORMAL BUT I'LL BREAK IT INTO FOUR PARTS 18 

FOR YOU. FIRST, PROCESS TO DATE AND THE STRATEGIES ANALYZED 19 

WHICH MANY OF YOU MAY BE WELL AWARE OF BUT I WANT TO MAKE SURE 20 

WE'RE ALL ON THE SAME PAGE. SECOND I'LL GO OVER THE FORECASTED 21 

OUTCOMES ASSOCIATED WITH THE STRATEGIES RECOGNIZING THAT THE 22 

FUTURE IS VERY UNCERTAIN RIGHT NOW. THIRD WE'LL TALK ABOUT 23 

WHETHER OR NOT THE DRAFT BLUEPRINT AND ENVISIONS PLANNED BAY 24 

AREA 2050 AND THE ENGAGEMENT SO WE CAN FOCUS AND COLLABORATE 25 
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IN THE MONTHS AHEAD AND FOURTH OPPORTUNITIES TO GET ENGAGED IN 1 

THE PLANNING BLUEPRINT PROCESS. LET'S DIVE IN. NEXT SLIDE 2 

PLEASE. NEXT SLIDE. THANK YOU. SO, FIRST OF ALL, WE HAVE TO 3 

ACKNOWLEDGE THAT A LOT OF THESE STRATEGIES HAVE BEEN THROUGH A 4 

ROBUST PROCESS TO DATE, THE ANALYSIS IN FEBRUARY WAS BASED ON 5 

STRESS TEST HORIZON INITIATIVES IN 2018 AND 2019. WE TESTED 6 

HOW THESE STRATEGIES PERFORMED UNDER A WIDE VARIETY OF 7 

CONDITIONS UNDER THREE DIVERGENT FUTURES AND STRATEGIES THAT 8 

ARE TRULY RESILIENT TO THE UNCERTAINTIES AHEAD AS WELL AS 9 

STRATEGIES THAT ADVANCE KEY EQUITY GOALS. NEXT SLIDE. OF 10 

COURSE WHEN WE CREATE PLANNED BAY AREA 2050, WE MUST ADHERE TO 11 

FEDERAL AND STATE GUIDELINES. AND THIS MEANS THAT WHILE WE'RE 12 

ABLE TO EXPLORE DIVERGENT PROCESSES, RECOGNIZING THAT THE 13 

FUTURE IS VERY UNCERTAIN. IMPORTANTLY WE DON'T DO THIS ON OUR 14 

OWN. IN FACT THE CALIFORNIA AIR RESOURCES BOARD IS A KEY 15 

PARTNER AND REGULATOR OF MANY OF THE ASSUMPTIONS. WE WORK WITH 16 

THEM TO VET DIFFERENT ASSUMPTIONS INCLUDING THE FOUR SHOWN ON 17 

SCREEN HERE. I THINK IT'S REALLY IMPORTANT HERE TO UNDERSCORE 18 

THAT THE BACKGROUND CONDITIONS OUTSIDE OUR CONTROL OFTEN MAKE 19 

IT HARDER NOT EASIER TO ACHIEVE THE REGIONAL VISION. AS WE 20 

LOOK TO THE FUTURE WE ANTICIPATE A POPULATION CONTINUES TO BE 21 

WEALTHIER, WITH LOWER COST OF DRIVING LEADING TO HIGHER 22 

GREENHOUSE GAS EMISSIONS MORE AUTO USE FURTHER AWAY FROM 23 

REGIONAL GOALS ADOPTED IN 2019. AND TELECOMMUTING WE WORKED 24 

WITH THE AIR RESOURCES BOARD TO ENSURE THAT WE ARE USING A 25 
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MORE OPTIMISTIC CURVE FOR TELECOMMUTING ADOPTION WHICH WILL 1 

LEAD TO ONE OUT OF THREE OFFICE WORKERS DOING SO ON A REGULAR 2 

BASIS ON ANY DAY IN THE FUTURE. NEXT SLIDE. OF COURSE WE WANT 3 

TO BENCH THOSE CURVES AND MOVE CLOSER TO THE REGIONAL VISION 4 

DESPITE HEADWINDS THE REGION MAY EXPERIENCE IN THE DAYS AHEAD. 5 

AND THAT'S WHERE THE DRAFT BLUEPRINT COMES IN 25 STRATEGIES IN 6 

THE LONG RAGE PLAN TRANSPORTATION, HOUSING, ECONOMY, AND 7 

ENVIRONMENT. WE USE THIS PUZZLE PIECE GRAPHIC PRECISELY 8 

BECAUSE WE SEE THIS AS AN INTEGRATED PROPOSAL RECOGNIZING PAST 9 

PLANS FOCUSED ON TRANSPORTATION ISN'T ENOUGH TO GET US TO THE 10 

FUTURE THAT WE ALL WANT TO SEE, A FUTURE THAT'S MORE 11 

AFFORDABLE, CONNECTED, DIVERSE, HEALTHY AND VIBRANT. IN FACT 12 

TRANSPORTATION PROJECTS ARE JUST A SMALL BUT IMPORTANT PIECE 13 

OF THE PUZZLE THAT WE HAVE BUNDLED TOGETHER INTO SOME KEY 14 

TRANSPORTATION STRATEGIES. BUT UNLESS WE DO WITH THEM WITH 15 

OTHER TRANSPORTATION STRATEGIES, HOUSING, STRATEGIES, ECONOMIC 16 

AND ENVIRONMENTAL STRATEGIES IT WILL BE IMPOSSIBLE TO GET TO 17 

OUR GOALS AND THOSE STRATEGIES ARE MORE EFFECTIVE AT ADVANCING 18 

THE REGIONAL GOALS, LIKE ROADWAY PRICING, TRANSIT HUBS AND 19 

HIGH RESOURCE AREAS AND KEY PROTECTIONS OF SEGMENTS OF SHORE 20 

LINES THOSE ARE ALL EQUALLY IMPORTANT WITH MAKING PROGRESS ON 21 

THINGS LIKE GREENHOUSE GAS EMISSIONS REDUCTIONS. NEXT SLIDE. 22 

MANY OF YOU ARE AWARE OF WHAT A STRATEGY IS BUT I WANT TO 23 

UNDERSCORE WHAT IT MEANS IN THE PLANNED BAY AREA 2050 PROCESS. 24 

WHEN WE TALK STRATEGIES, WHAT WE MEAN IS IT'S A PUBLIC POLICY 25 
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OR SET OF INVESTMENTS THAT CAN BE IMPLEMENTED IN THE REGION 1 

OVER THE NEXT 30 YEARS. NOT NEAR TERM PROPOSALS OR LEGISLATIVE 2 

IDEAS, THEY'RE THINGS THAT CAN BE IMPLEMENTED AT THE REGIONAL 3 

LOCAL AND STATE LEVEL. AND THE IMPLEMENTATION ACTIONS THROUGH 4 

MTC AND ABAG WILL BE IDENTIFIED THROUGH THE IMPLEMENTATION 5 

PLAN PROCESS LOOKING OVER THE NEXT 4 TO 5 YEARS AND THAT 6 

PROCESS WILL BEGIN AFTER THE PRESENTATION OF THE FINAL 7 

BLUEPRINT RESULT. OF COURSE WE CAN'T INCLUDE EVERY STRATEGY IN 8 

THE BLUEPRINT. IT MUST BE FISCALLY CONSTRAINED. WHAT YOU SEE 9 

TODAY IS A REFLECTION OF THE FISCAL CONSTRAINT, WE DON'T 10 

ALWAYS GET TO THE GOALS THAT ARE SET BUT MAKE MEANINGFUL 11 

PROGRESS. NEXT SLIDE. A LOT OF THE FEEDBACK THAT ALL OF YOU 12 

PROVIDED US, THE WORKSHOPS AND STAKEHOLDERS IN THE FALL AS 13 

WELL AS SPEAKING WITH TENS OF THOUSANDS OF BAY AREA RESIDENTS 14 

NOT ONLY IN THE FALL OF 2019 BUT IN PRIOR OUTREACH CYCLES FOR 15 

HORIZON, WE HAVE GOTTEN SOME GREAT FEEDBACK THAT ALLOWED US TO 16 

RESIGN THE STRATEGIES THAT GO INTO THE ON BLUEPRINT. WHAT WE 17 

RECEIVED IN THE FALL 2020 OUTREACH ARE CLOSER TO THE REGIONAL 18 

VISION. NEXT SLIDE. WE HAVE INCLUDED IN ATTACHMENT B, THE FULL 19 

LIST OF ALL 25 STRATEGIES THAT ARE BEING ANALYZED THROUGH THE 20 

DRAFT BLUEPRINT PROCESS CLUSTERED UNDER THE NINE THEMES AT THE 21 

LEFT. STRATEGIES TO OPTIMIZE GOODS AND TRANSPORTATION 22 

INFRASTRUCTURE CREATE SAFE AND HEALTHY STREETS AND TRANSIT 23 

SYSTEMS, HOUSING AND INCLUDING COMMUNITIES AND TO PROTECT AND 24 

PRESERVE MORE AFFORDABLE HOUSING. ENVIRONMENT STRATEGIES 25 
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DESIGNED TO REDUCE RISK FROM HAZARDS AND REDUCE IMPACT ON THE 1 

ENVIRONMENT. ON THE ECONOMIC FRONT WE'RE WORKING TO IMPROVE 2 

ECONOMIC MOBILITY AND SHIFT OF THE LOCATION OF JOBS. IN SOME 3 

CASES, OUR STRATEGIES APPROVE SUFFICIENT TO ACTUALLY GET TO 4 

THESE GOALS AND OTHERS FALL SHORT AND TODAY WE'LL SHOW 5 

MULTIPLE STRATEGIES. NEXT SLIDE. OF COURSE A LOT HAS CHANGED 6 

SINCE FEBRUARY 2020 WHEN THE STRATEGIES WERE APPROVED FOR 7 

ANALYSIS. YOU MIGHT NATURALLY ASK HOW DO THESE CURRENT 8 

CHALLENGES RELATED TO COVID-19 IN A MAJOR GLOBAL RECESSION 9 

AFFECT SOME OF THE DECISION MAKING OF PLANNED BAY AREA 2050. 10 

OF COURSE WE GAVE A PRESENTATION ON SOME DATES WE MADE TO OUR 11 

REGIONAL GROWTH FORECAST TO NEAR TERM IMPACTS ON THIS FRONT. A 12 

FEW THINGS TO NOTE, THE PLAN IS A 30 YEAR DOCUMENT AND A LOT 13 

OF THESE IMPACTS WILL FIND THEMSELVES IN THE NEXT 5 TO 10 14 

YEARS AND THAT'S WHERE THE IMPLEMENTATION PLAN CAN SERVE A KEY 15 

ROLE. SECOND, WHILE WE DIDN'T STUDY A PANDEMIC, A LOT OF THE 16 

FORCES COMING WITH IT HIGH LEVEL TELECOMMUTING OR PERHAPS 17 

REDUCED INTEREST IN SHARING SORRY VEHICLES FOR TRANSPORTATION 18 

OR OTHER PURPOSES, WE HAVE STUDIED THESE THINGS AND STRETCHED 19 

STRATEGIES THROUGH THEM ALREADY SO WE KNOW THESE STRATEGIES 20 

WILL HELP MOVE THE REGION FORWARD REGARDLESS OF WHAT HAPPENS 21 

ON A VARIETY OF THOSE DIFFERENT PATHS. SOME OF THE STRATEGIES 22 

BEING STUDIED IN THE DRAFT BLUEPRINT SEEM MORE TIMELY TODAY 23 

THINGS LIKE ADVANCING QUICK FILL BICYCLE IMPROVEMENTS AND 24 

PEDESTRIAN IMPROVEMENTS INTEGRATION OF PROTECTIONS FOR 25 
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DISPLACEMENT, CHILD CARE NEEDED SO CLEARLY IN THIS TIME AND 1 

PREDICTING THAT MUCH NEEDED OPEN SPACE THAT WE ALL NEED TO GET 2 

OUT OF OUR HOMES AND GET SOME TIME IN NATURE, AND THE 3 

ENVIRONMENT. SO THESE ARE JUST A FEW OF THE 25 STRATEGIES BUT 4 

THESE ONES IN PARTICULAR SEEM VERY TIMELY TODAY. ALL THAT 5 

BEING SAID THIS SUMMER IS A GREAT OPPORTUNITY TO NOT JUST LOOK 6 

AT WHETHER THE DRAFT BLUEPRINT STRATEGIES PERFORM WELL BUT TO 7 

LOOK AT WITH A FRESH PERSPECTIVE, FRESH SET OF EYES TO MAKE 8 

SURE WE'RE NOT MISSING ANYTHING IN THE COVID ERA. NEXT SLIDE. 9 

ANOTHER ASPECT OF WHAT WE HAVE STUDIED IN THE DRAFT BLUEPRINT 10 

ARE GROWTH GEOGRAPHIES. WE'RE TRYING TO ENCOURAGE GROWTH, 11 

PROTECTING AREAS OUTSIDE OF URBAN GROWTH AREAS, AND IN 12 

UNMITIGATED HIGH HAZARD AREAS AND THE GROWTH SHOWN ON THE MAP 13 

HERE IN THE RED, BLUE, ORANGE, AND LIGHT BLUE. WE HAVE A WIDE 14 

VARIETY OF GROWTH GEOGRAPHIES OF PLANNED BAY AREA 2050, 15 

LOOKING AT CHANGES BEYOND PRIORITY DEVELOPMENT AREAS THAT ARE 16 

RICH AND HIGH RESOURCE IN ORDER TO ADVANCE CLIMATE EQUITY 17 

GOALS. IT SHOWS PRIORITY DEVELOPMENT AREAS NOMINATED BY LOCAL 18 

JURISDICTION AS WELL AS ADDITIONAL TRANSIT-RICH AND HIGH 19 

RESOURCE AREAS THAT HELP TO ENCOURAGE MORE GROWTH IN COMMUNITY 20 

THAT HAVE NOT NOMINATED A SIGNIFICANCE NUMBER OF PRIORITY 21 

DEVELOPMENT AREAS. NEXT SLIDE. SO, ONE OTHER ASPECT BEFORE WE 22 

GET INTO SOME OF THE KEY OUTCOMES OF THE DRAFT BLUEPRINT IS TO 23 

REMEMBER THAT REVENUES ARE A CRITICAL PART OF THE PICTURE 24 

HERE. PLANNED BAY AREA 2050 IS MORE A STRATEGY PLAN THAN 25 
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PREVIOUS ITERATIONS OF PLANNED BAY AREA FOCUSED ON THE 25 BIG 1 

STRATEGIES TO MOVE THE REGION FORWARD BUT OF COURSE IT STILL 2 

NEEDS TO BE FISCALLY CONSTRAINT AND FOR TRANSPORTATION THAT'S 3 

A STATUTORY REQUIREMENT. THIS GRAPHIC SHOWS A BREAK DOWN OF 4 

TOTAL COST FOR EACH ELEMENT OF THE PLAN. THIS INCLUDES 5 

FUNCTIONS THAT REGIONAL NEW REVENUES THAT ARE ESSENTIAL TO 6 

MAKE PROGRESS TOWARDS OUTCOMES IN SAFE PRESENTATIONS. YOU WILL 7 

NOTE THERE ARE ROUGHLY 200 IN NEW REVENUES ACROSS THE ELEMENT 8 

AND THIS HELPS MOVE TOWARDS THOSE GOALS IN A MEANINGFUL WAY. 9 

SHOWN IN THE PIE CHART IN THE LIGHTER COLORS. CAVEAT NOTES 10 

HERE FIRST OF ALL IN TRANSPORTATION YOU WILL SEE A LARGE PIE 11 

CHART ON THE LEFT SIDE THAT REFLECTS OVER $500 BILLION FOR 12 

TRANSPORTATION. ULTIMATELY IN THE DRAFT BLUEPRINT WE DO NOT 13 

SPEND ALL THE MONIES HERE THERE IS A RESERVE FOR THE FINAL 14 

BLUEPRINT GIVEN THE NUMBER OF TRANSPORTATION PROJECTS THAT ARE 15 

BORDER LINE TO BE INTEGRATED INTO FINAL BLUEPRINT STRATEGIES 16 

TO PROVIDE NEW COMMITMENT TO REFINE YOU WILL FIND THAT IN THE 17 

NEXT PRESENTATION. IMPORTANT CAVEAT, THERE ARE NEW REVENUES 18 

FOR NEW HOUSING THERE IS STILL IMMENSE GAP IN FUNDING FOR 19 

AFFORDABLE HOUSING IN THE BAY AREA. NEARLY $400 BILLION NEEDS 20 

TO BE SET ASIDE FOR REVENUE ADDRESS. HOW TO CONTINUE THE GAP 21 

WILL BE IMPORTING IN THE FINAL BLUEPRINT. THE FINAL BLUEPRINT 22 

REPRESENTS OPPORTUNITY FOR HOW WE'RE SLICING THE PIE SO TO 23 

SPEAK FOR EACH OF THE DIFFERENT AREAS. IT'S IMPORTANT TO 24 

REMEMBER THAT THAT ALONE IS NOT ENOUGH. LOW COST AND NO COST 25 
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STRATEGIES THAT AUGMENT OUR FINANCIAL INVESTMENTS FOR 1 

TRANSPORTATION OR FOR HOUSING THEY CAN MOVE THE NEEDLE MUCH 2 

MORE SO THAN THE DIRECT INVESTMENTS. NEXT SLIDE PLEASE. YOU 3 

MAY BE WONDERING HOW WE ANALYZE THE DRAFT BLUEPRINT. SO OF 4 

COURSE THE STRATEGIES AND THESE ARE SOME OF THE KEY INPUTS OF 5 

THE PROCESS THAT WERE APPROVED FOR THE ANALYSIS IN FEBRUARY OF 6 

2020. WE LAYER THOSE ON TOP OF BASELINE DATA INCLUDING DATA 7 

THAT CAME FROM OUR BASIS INITIATIVE WHERE WE GOT UPDATED 8 

INFORMATION FROM COUNTIES AND CITIES TO INCORPORATE IN OUR 9 

LAND USE MODELS. WE THEN WENT THROUGH AN ANALYSIS PROCESS 10 

USING ALL THREE OF OUR MODELS WITH THE REMI MODEL FOR ECONOMIC 11 

ISSUES, URBAN SIM 2.0 MODEL FOR LAND USE AND MODEL 2.15 FOR 12 

THE FOR ALL INTENT AND PURPOSE SIDE. WHEN YOU ANALYZE ALL 13 

THESE THINGS TOGETHER YOU IDENTIFY OUTCOMES THINGS REFLECTED 14 

BY PERFORMANCE METRICS FOR GROWTH PATTERNS AND SUCH THAT'S 15 

WHAT WE'RE RELEASING THIS MONTH, THE NEW PIECE OF THE TOOL. 16 

BRIEF NOTE HERE DRAFT BLUEPRINT IS THE RESULT OF 25 STRATEGIES 17 

THOSE OF YOU IN THE KNOW ON PLANNED BAY AREA 2050 YOU MAY KNOW 18 

WE WERE GOING TO EXPLORE THREE VERSIONS OF THE DRAFT BLUEPRINT 19 

IN THE POST COVID ERA, THE SWEAR HAD CHANGED, AND SO THE 20 

ANALYSIS TODAY REFLECTS CLOSELY TODAY THE DRAFT BLUEPRINT PLUS 21 

WITH A MAJOR NEW MEASURE AND THE FULL SUITE OF STRATEGIES. 22 

NEXT SLIDE. NOW MOVING TO PART TWO OF THE PRESENTATION 23 

FOCUSING ON THE POTENTIAL OUTCOMES OF THE DRAFT BLUEPRINT. AND 24 

I WANT TO UNDERSCORE THAT THE IMPORTANCE OF POTENTIAL, THIS IS 25 
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REALLY WHY WE DID THE HORIZON INITIATIVE, WE RECOGNIZE THOSE 1 

POTENTIAL OUTCOMES HANG ON THE POTENTIAL PHASES. WE DID OUR 2 

BEST TO FORECAST WHAT THE REGION MIGHT LOOK LIKE WITH THE 3 

BASELINE ASSUMPTIONS AS WELL AS STRATEGIES ANALYSIS. WE'RE 4 

GOING TO START OFF WITH HIGHLIGHTS ALTHOUGH THERE ARE 5 

CHALLENGES WE'RE GOING TO TALK ABOUT, AND STRATEGIES TO BE 6 

FOCUSED ON WITH WORKSHOPS AND PUBLIC ENGAGEMENT THERE IS A LOT 7 

OF GOOD NEWS OF THE DRAFT BLUEPRINT AREAS WHERE WE HAVEN'T 8 

BEEN ABLE TO MAKE MUCH PROGRESS IN PRIOR ITERATIONS OF PLANNED 9 

BAY AREA. FIRST OF ALL I WANT TO TALK ABOUT AFFORDABILITY. 10 

BECAUSE WE ALL KNOW THAT'S WHAT OF THE BIGGEST CHALLENGES AND 11 

PART OF OUR KEY GUIDING PRINCIPLES TO MAKE THE BAY AREA MORE 12 

AFFORDABLE. AND HAPPY TO SHARE THAT THANKS TO THE ROBUST 13 

HOUSING AT ALL INCOME LEVELS, THE STRATEGIES, THAT WE HAVE 14 

FINALLY BEEN ABLE TO MAKE HEADWAY ON MAKING THE BAY AREA MORE 15 

AFFORDABLE FOR ALL RESIDENTS. IN 2015 THE COST OF HOUSING 16 

ACCOUNTED FOR 57 PERCENT OF A TYPICAL BUDGET IN THE BAY AREA 17 

AND ALTHOUGH IT'S STILL HIGH WE HAVE BEEN ABLE TO REDUCE THAT 18 

BY ROUGHLY NINE PERCENT THANKS TO THE STRATEGIES IN THE DRAFT 19 

BLUEPRINT AND PAST ITERATIONS OF PLANNED BAY AREA HAVE 20 

INCREASE IN THAT, SO THAT'S A MAJOR IMPROVEMENT COMPARED TO 21 

PREVIOUS PLANS. NEW REVENUES IN PLANNED BAY AREA 2050 ALSO 22 

ENABLE US TO INCREASE THE AMOUNT OF DEED RESTRICTED IN THE 23 

PLAN ROUGHLY 400,000 MORE UNITS OF DEED RESTRICTED HOUSING BY 24 

2050 AND THIS IS MAKING SURE THE LOW INCOME RESIDENTS WHO ARE 25 
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EXTREMELY BURDENED BY HOUSING COST THAT WE BRING DOWN THAT 1 

BURDEN AND WE SEE THAT IN AFFORDABILITY METRICS AS WELL. OTHER 2 

PIECES OF GOOD NEWS WE'RE SEEING MORE GROWTH NEAR TRANSIT WITH 3 

43 PERCENT OF ALL HOMES IN THE BAY AREA ARE WITHIN A HALF MILE 4 

WALK OF HIGH FREQUENCY TRANSIT IN THE SORT OF WALKABLE 5 

COMMUNITIES AND MORE FREQUENT TRANSIT THAT'S UP FROM 32 6 

PERCENT IN 2015. NEXT SLIDE. PIVOTING TO THE ENVIRONMENTAL 7 

ASPECTS OF THE PLAN STRATEGIES TO REDUCE VEHICLE SPEEDS AND 8 

BUILD PROTECTED PEDESTRIAN AND BICYCLE INFRASTRUCTURE HELP US 9 

AVOID 1500 FATALITIES OVER THE LIFESPAN OF THE PLAN THAT'S A 10 

VERY SIGNIFICANT NUMBER OF LIVES AND RETROFITTING HOMES AND 11 

BUILD SEA WALLS LEVIES AND OTHER SORTS OF SEA LEVEL RISE 12 

INFRASTRUCTURE PROTECT 100 PERCENT OF HIGH RISK HOMES AND 98 13 

PERCENT OF HOMES AT RISK FROM SEA LEVEL RISE MEANINGFUL GAINS 14 

ON THE PLAN AS WELL. IN THE TAX INCREASES REQUIRED TO PAY FOR 15 

MANY ASSIST BOLD NEW STRATEGIES, ECONOMIC MODEL IS SHOWING THE 16 

REGION'S ECONOMY REMAINS POISED FOR SIGNIFICANT GROWTH OVER 17 

THE COMING YEARS THOSE PAST INCREASES WILL PAY FOR IMPORTANT 18 

INVESTMENTS FOR TRANSPORTATION, HOUSING, AND THE LIKE TO HELP 19 

ENABLE MORE ECONOMIC GROWTH IN THE FUTURE. NEXT SLIDE. A FEW 20 

OTHER AREAS. NEXT WE'RE GOING TO TALK A LITTLE BIT ABOUT THE 21 

REGIONAL GROWTH FORECAST FOR THE OTHER YEARS TO REFLECT 2019 22 

AND THE REFLECTION OVER THE NEXT TEN YEAR TIME PERIOD. THE 23 

DRAFT BLUEPRINT INCORPORATES 1.5 MILLION NEW HOUSING UNITS 24 

OVER THE 35 YEAR TIME HORIZON. THIS ADDITIONAL HOUSING IS 25 
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EXTREMELY HELPFUL IN TERMS OF ENSURING THAT ALL RESIDENTS ARE 1 

ABLE TO HAVE A ROOF OVER THEIR HEADS AND NOT BE DISPLACED OUT 2 

OF THE BAY AREA. NEXT SLIDE. WHERE EXACTLY IS THAT HOUSING 3 

GOING AS A RESULT OF THE STRATEGIES THAT ARE INTEGRATED IN THE 4 

DRAFT BLUEPRINT? SO NOTABLY THE DRAFT BLUEPRINT INCLUDES 5 

ADDITIONAL DEVELOPMENT CAPACITY IN AREAS NEAR HIGH FREQUENCY 6 

TRANSIT AND HIGH RESOURCE COMMUNITIES WITH WELL RESOURCED 7 

SCHOOLS, PARKS, ACCESS TO JOBS, AND THE LIKE. WE HAVE COMPARED 8 

PLANNED BAY AREA 2050 HOUSING GROWTH PATTERN WITH THAT OF 9 

PLANNED BAY AREA 2040. AND YOU CAN SEE ON THE RIGHT HAND SIDE, 10 

THAT THE, YOU KNOW, WE'RE SHOWING A BUBBLE THAT REFLECTS THE 11 

TOTAL NUMBER OF HOUSING UNITS -- SORRY -- TOTAL NUMBER OF NEW 12 

HOUSEHOLDS IN EACH OF THE NINE COUNTIES. THIS CYCLE IS THE 13 

ADDITIONAL GROWTH IN SILICON VALLEY GIVEN THE DEVELOPMENT 14 

POTENTIAL ON THOSE LOCATIONS AS WELL AS THE STRATEGIES APPLIED 15 

THERE. WE'RE SEEING A SIGNIFICANT SHARE, 41 PERCENT OF ALL NEW 16 

HOUSEHOLDS LOCATING IN THOSE AREAS VERY CLOSE TO JOBS IN THE 17 

SOUTH BAY. YOU WILL ALSO SEE A FEW KEY STATISTICS DOWN ON THE 18 

BOTTOM LEFT WE'RE SEEING SLIGHTLY LESS GROWTH IN PRIORITY 19 

DEVELOPMENT AREAS. THAT'S TO BE EXPECTED GIVEN THE GREATER 20 

FOCUS ON TRANSIT-RICH AND HIGH RESOURCE AREAS WE'RE SEEING 21 

MORE GROWTH IN THE TRANSIT-RICH AREAS AND MORE GROWTH IN THE 22 

HIGH RESOURCE AREAS SO SOME MEANINGFUL STEPS THERE. NOTABLE 23 

MORE GROWTH IN THE BAYSIDE CITIES, CITIES WHICH TOUCH SAN 24 

FRANCISCO BAY LESS GROWTH IN THE THREE -- OUTSIDE THE SOUTH 25 
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BAY YOU WILL GENERALLY SEE THE NORTH BAY PATTERNS SIMILAR TO 1 

THE PAST PLANS WITH SLIGHTLY MORE GROWTH IN SONOMA AND MARIN 2 

COUNTIES. NEXT SLIDE PLEASE. PIVOTING NEW TO JOBS WE'RE SEEING 3 

A SIMILAR TREND HERE. OUR STRATEGIES THAT WERE DESIGNED TO 4 

ADDRESS THE JOBS HOUSING BALANCE GENERALLY PROVED INEFFECTIVE 5 

AT SHIFTING JOBS FROM THE SOUTH BAY TO THE EAST BAY. JOBS ARE 6 

SHIFTING CLOSER TO JOBS IN THE SILICON VALLEY AREAS WE'RE 7 

MAKING HEADWAY STRETCHES THE JOBS HOUSING BALANCE BY MOVING 8 

CLOSER TO JOBS THAN MOVING CLOSER TO HOUSING. LET'S TALK ABOUT 9 

TRANSPORTATION FOR A MINUTE. AS YOU CAN SEE HERE ON THE LEFT, 10 

WE HAVE A GRAPHIC THAT SHOWS THE COMMUTE MODE CHOICES. IN 11 

2015, AND ALSO FORECASTED MODE CHOICE IN 2050 UNDER BLUEPRINT 12 

CONDITIONS. NOTABLY WE SEE AN ALMOST 20 POINT REDUCTION IN 13 

AUTO MODE SHARE AS A RESULT OF A COMBINATION OF FORCES. SO, 14 

FIRST WE SEE INCREASED GROWTH IN THE TRANSIT AND BICYCLE AND 15 

PEDESTRIAN MODES THANKS TO SOME OF THE KEY BUS, BIKE, AND BART 16 

INVESTMENTS INCLUDED IN THE DRAFT BLUEPRINT BUT WE ALSO SEE 17 

SIGNIFICANT INCREASE IN TELECOMMUTING AS WELL ACCOUNTING FOR 18 

14 PERCENT. -- NEXT SLIDE. WITH REGARDS TO SEA LEVEL RISE LOTS 19 

OF GOOD NEWS HERE. WE HAVE INCLUDED SOME SIGNIFICANT 20 

INVESTMENTS IN LEVIES, MARSH RESTORATIONS AND THE LIKE AS PART 21 

OF PLACE HOLD STRATEGIES FOR SEA LEVEL RISE IN THE DRAFT 22 

BLUEPRINT THIS INCLUDES PROTECTIONS OF 89,000 HOMES AND 23 

166,000 JOBS IT ALSO INCLUDES 100,000 ACRES OF MARSH 24 

RESTORATION PROJECTS AND PROTECTS HOW LONG AND RAIL CORRIDORS 25 
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FOR ANTICIPATED SEA LEVEL RISE IN THE YEAR 2050. NEXT SLIDE 1 

PLEASE. A LOT GOING ON IN THIS GRAPHIC BUT I WANT TO PAUSE 2 

HERE BECAUSE GREENHOUSE GAS EMISSIONS REDUCTION IS A STATUTORY 3 

REQUIREMENT OF PLANNED BAY AREA 2050. LET'S WALK THROUGH THIS 4 

GRAPHIC BRIEFLY. SO 50 OF ALL, THAT TOP ROW REFLECTS PLANNED 5 

BAY AREA 2040 WHICH WAS ADOPTED IN 2017 IT BARELY MET THE 6 

TARGET AT THE TIME. WHICH WAS A 15 PERCENT PER CAPITA 7 

REDUCTION FOR CARS AND LIGHT DUTY TRUCKS BETWEEN 2005 AND 8 

2035. IN 2018, OUR INCREASE OF THE TARGET TO 19 PERCENT PER 9 

CAPITA REDUCTION. GOING INTO PLANNED BAY AREA 2050 PROCESS WE 10 

DID ANALYSIS REQUIRED BY CARB TO UNDERSTAND HOW THESE EXTERNAL 11 

FORCES I TALKED ABOUT THINGS LIKE THE WEALTH OF THE REGION, 12 

THE LEVEL OF TELECOMMUTING AND THE LIKE. COST OF DRIVING, 13 

WOULD EFFECT GREENHOUSE GAS EMISSIONS TRENDS AND UPDATED WITH 14 

2040 UPDATED ASSUMPTIONS WHICH INCLUDED HERE IS LOW COST TO 15 

DRIVE. THIS SIGNIFICANTLY CHANGED THE PICTURE FOR PLANNED BAY 16 

AREA 2040 AND REFLECTED A ONE POINT REDUCTION BY 2035 THOSE 17 

EXTERNAL FORCES ARE BEYOND OUR CONTROL HAVE AN IMPACT ON THE 18 

REGIONAL TREND. IF WE USE HIGHER COST TO DRIVE WE CAN SEE FOUR 19 

PERCENT REDUCTION BUT STILL A 15 POINT GAP. THAT BRINGS US 20 

DOWN TO WHAT DOES THE DRAFT BLUEPRINT DO FOR GREENHOUSE GAS 21 

EMISSIONS REDUCTIONS ESTIMATES ARE IT ACHIEVES EIGHT POINTS OF 22 

REDUCTION RATHER THAN SIMPLY ADOPTING PLANNED BAY AREA 2040 23 

BETWEEN 9 AND 12 PERCENT REDUCTION WE CONTINUE TO WORK WITH 24 

CARB ON THE OPERATING PROCESS ASSUMPTION WE LIKE TO USE THE 25 
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MODERATE COST TO DRIVE WHICH REFLECT A COST THAT IS LOWER THAN 1 

PLANNED BAY AREA 2040 REFLECTING THAT FUEL PRICES HAVE NOT 2 

GONE UP AS QUICKLY BUT INCLUDED TECHNICAL ASSUMPTION IN THERE. 3 

EVEN SO THERE WOULD BE A SEVEN POINT GAP REMAINING TO THE 19 4 

PERCENTAGE POINT TARGET AND THIS WILL BE A CRITICAL ISSUE THAT 5 

WILL HAVE TO BE RESOLVED AS PART OF THE FINAL BLUEPRINT IF THE 6 

REGION CONTINUES TO RECEIVE SUGGESTIONS FOR CORRIDORS FUNDING. 7 

DRAFT BLUEPRINT INCLUDED NO FUNDING FOR HIGHWAY EXPANSION 8 

THERE WERE GOING TO BE INVESTMENTS UNDER CONSIDERATION THAT 9 

COULD MAKE THE GAP EVEN BIGGER. NEXT SLIDE. PART THREE OF THE 10 

WALK THROUGH OF THE DRAFT BLUEPRINT. HOW DOES THE DRAFT 11 

BLUEPRINT ALINE WITH THE GUIDING PRINCIPLES ADOPTED IN 2019 12 

AND WHAT DO THE CHALLENGES MEAN? NEXT SLIDE. WE WANT TO SHARE 13 

AN OVERARCHING FINDING. FUTURES GROWTH AND ACTIONS OVER THE 14 

NEXT 30 YEARS ARE MORE EQUITABLE MORE RESILIENT THAN PAST 15 

GENERATIONS THERE HAS BEEN A LOT OF LEGACY INVESTMENTS AND 16 

LEGACY ACTIONS IN THE REGION THAT HAVE CREATED HUGE CHALLENGES 17 

FOR THE BAY AREA. BUT IF WE WANT TO RIGHT ALL THE WRONGS OF 18 

THE 20th CENTURY. A BOLDER DRAFT BLUEPRINT WOULD BE REQUIRED, 19 

TAKING BOLDER ACTION TO ADDRESS CRITICAL THINGS LIKE RACIAL 20 

INEQUITY IN REDLINING AND WHAT THAT HAS DONE TO CRITICAL 21 

SITUATIONS TODAY. NEXT SLIDE. IN THE PACKET YOU WILL SEE 22 

ATTACHMENT C WHICH INCLUDES A DETAILED BREAK DOWN OF DIFFERENT 23 

METRICS AND OUTCOMES FOCUSED ON MAKING SURE THE OUTCOMES ARE 24 

EQUITABLE LOOKING AT EQUITABLE AND LOW INCOME COMMUNITIES OF 25 
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CONCERN. QUESTION OF WHETHER THE DRAFT MOVES US TOWARDS THE 1 

GUYING PRINCIPLES AND VISION. WE DEVELOPED TWO QUESTIONS BASED 2 

ON FEEDBACK WE GOT AT STAKEHOLDER WORKSHOPS IN 2019 AND 2020. 3 

I WILL BRIEFLY GO THROUGH THE HIGH LEVEL FINDINGS FOR EACH 4 

SESSION, BUT I ENCOURAGE TO YOU GO THROUGH ATTACHMENT C AND 5 

VIEW THE METRICS IN THERE. NEXT SLIDE. LET'S START WITH 6 

AFFORDABILITY. DOES THE DRAFT BLUEPRINT MOVE US TO A MORE 7 

AFFORDABLE BAY AREA? THE SHORT ANSWER IS YES WITH SOME KEY 8 

CAVEATS. WE EXPECT TO SEE EVEN GREATER REDUCTION FOR LOWER 9 

INCOME HOUSING. AS I NOTE THE BEFORE THIS IS THE FIRST PLANNED 10 

BAY AREA THAT MADE HEADWAY ON THAT METRIC AND THE FACT THAT 11 

WE'RE SEEING GREATER GAINS FOR LOWER INCOME HOUSEHOLDS IS 12 

PRIORITY FOR US IN CREATING AN EQUITY FIRST PLAN. ON THE 13 

TRANSPORTATION SIDE WE'RE SEEING MEANS-BASED TOLL ARE 14 

EFFECTIVE IN MITIGATING IMPACTS AND MEANS-BASED FARES IMPACT. 15 

EFFICACY OF MEANS-BASED STRATEGIES. SECOND QUESTION FOR 16 

AFFORDABILITY WILL THE BAY AREA PRESERVE AFFORDABLE HOUSING? 17 

YES. WITH THE FINANCIAL SHORT FALL THERE IT WOULD REMAIN A 18 

REGIONAL EXISTING NEED. THE DRAFT BLUEPRINT HAS ENOUGH MONEY 19 

TO PERMANENTLY PROTECT THE AT RISK DEED RESTRICTED UNITS AND 20 

PRODUCE THE SAME AMOUNT OF NEW UNITS FOR ALL HOUSING GROWTH 21 

GOING FORWARD BUT IN ORDER TO ENSURE ALL THE EXISTING LOW 22 

INCOME HOUSEHOLDS IN THE REGION HAVE DEED RESTRICTED UNITS 23 

THAT WOULD REQUIRE MORE FUNDING FOR PLANNED BAY AREA 2050. IF 24 

YOU THINK ABOUT THE FINAL BLUEPRINT HOW DO WE FURTHER INCREASE 25 
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PRODUCTION OF LOW INCOME AFFORDABILITY ESPECIALLY IN HIGH 1 

RESOURCE AREAS WHERE THEY WOULD HAVE ACCESS TO SOME OF THE 2 

BEST RESOURCE SCHOOLS AND GREATEST ACCESS TO JOBS. NEXT SLIDE. 3 

WHAT ABOUT MAKING THE BAY AREA MORE CONNECTED. FIRST OF ALL WE 4 

LOOKED AT WHETHER BAY AREA RESIDENTS WILL BE ABLE TO ACCESS 5 

TRANSIT THE SHORT ANSWER IS NO FOR -- AND -- THANKS IN PART TO 6 

THE BUS AND BART INVESTMENT IN THE DRAFT BLUEPRINT BUT THANKS 7 

TO THE LAND USE PATTERNS WHICH HAS MORE GROWTH CLUSTERED TO 8 

MAJOR JOB CENTERS IN PLACES LIKE THE SOUTH BAY. WITH REGARDS 9 

TO AUTO, WE'RE SEEING RISE IN TRAFFIC CONGESTION GENERALLY 10 

ASSOCIATED WITH THE POPULATION GROWTH OF THE REGION AND VERY 11 

LIMITED EXPANSION OF THE ROADWAY SYSTEM AND WHEN COMBINED WITH 12 

REDUCED SPEED LIMITS IT'S A SECONDARY FACTOR THIS IS PLAYING A 13 

ROLE IN REDUCING AUTOMOBILE ROLE ACCESS. SOMETHING THEY CAN 14 

RELY ON IN 2050 THE ANSWER IS DEPENDING ON THE CORRIDOR AND 15 

THE OPERATOR. MEANS BASED TOLLS ARE HELPING TO REDUCE 16 

CONGESTION BUT THE TOLL RATES ARE SOMETIMES INSUFFICIENT TO 17 

MITIGATE IMPACTS ON THE GROWING POPULATION AND TRANSBAY RAIL 18 

CROSSING ARE ABLE TO ADDRESS BUT NEW CROWDING CHALLENGES AMONG 19 

OTHER CORRIDORS EXPRESS BUSSES AND OTHER RAIL SYSTEMS. KEY 20 

CHALLENGE HERE NEW STRATEGIES BETTER ADDRESS TRAFFIC 21 

CONGESTION AND TRANSIT OVERCROWDING AS WE GO INTO THE DRAFT 22 

BLUEPRINT. NEXT SLIDE. WHAT ABOUT THE REGION'S DIVERSITY HOW 23 

ARE WE ENSURING THE REGION PRESERVES DIVERSITY AND BECOMES 24 

MORE DIVERSE IN THE FUTURE? ARE BAY AREA COMMUNITIES MORE 25 
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INCLUSIVE AS A RESULT OF THE DRAFT BLUEPRINT. WE SEEING 1 

CHANGES IN THE HIGH RESOURCE AREAS BUT WE SEE BREAK DOWNS BY 2 

GENTRIFICATION AND DISPLACEMENT IMPACT IN ATTACHMENT C. WE'RE 3 

SEEING HIGH RESOURCE AREAS NOT NOMINATED IN THE -- 4 

HISTORICALLY, AT THE SAME TIME MANY OF THE TRANSIT-RICH AREAS 5 

APPEAR AT RISK OF GENTRIFICATION AS WE'RE LOOKING AT 6 

INCREASINGLY WEALTHY DEMOGRAPHIC PROFILE AND MUCH GROWTH 7 

OCCURRING NEAR TRANSIT. SECOND WILL BAY AREA RESIDENTS BE ABLE 8 

TO STAY IN PLACE CHALLENGING NEWS HERE NOT OVER THE LONG-TERM 9 

WITHOUT FURTHER MITIGATION ROBUST RENTER PROTECTION STRATEGIES 10 

IN THE DRAFT BLUEPRINT THOSE GAINS ARE REALLY ONLY A SHORT-11 

TERM RELIEF AND IF WE'RE TRYING TO ADDRESS LONG-TERM 12 

DISPLACEMENT ADDITIONAL STRATEGIES OR ACTIONS WOULD BE 13 

REQUIRED AND THIS CUES UP THE KEY CHALLENGE HERE WHICH IS 14 

ENSURING WE CAN REDUCE RISK OF DISPLACEMENT SO MORE BAY AREA 15 

RESIDENTS CAN STAY IN PLACE IN THE FINAL BLUEPRINT NEXT SLIDE. 16 

WHAT ABOUT THE ENVIRONMENT AND THE HEALTH OF BAY AREA 17 

RESIDENTS? THE DRAFT BLUEPRINT MOVING IN THE RIGHT DIRECTION 18 

THERE? FIRST BAY AREA RESIDENTS HEALTHIER AND SAFER? YES WITH 19 

KEY CAVEAT THAT MORE WOULD BE NEEDED FOR ROADWAY SAFETY IF WE 20 

WANT TO IMPROVE OUR REGION. PROTECTING HOPELESS FROM SEA LEVEL 21 

RISE AND RESILIENCE INVESTMENTS BUT ON THE ROADWAY SAFETY 22 

FRONT WHILE WE'RE SEEING MEANINGFUL GAINS WE WOULD NEED MORE 23 

STRATEGIES TO ACHIEVE THE ASPIRATIONAL GOALS OF VISION ZERO. 24 

WHAT ABOUT THE ENVIRONMENT HOW ARE WE AFFECTING THE 25 
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ENVIRONMENT AS A RESULT OF THE DRAFT BLUEPRINT YOU SAW THE 1 

GREENHOUSE GAS EMISSIONS SLIDE WE ARE SEEING MEANINGFUL GAINS 2 

IN TERMS OF EIGHT PERCENTAGE POINTS OF IMPROVEMENT IN TERMS OF 3 

PLANNED BAY AREA 2040 BUT MORE REDUCTIONS WILL BE NEEDED TO 4 

ACHIEVE OR SURPASS THE STATE-MANDATED TARGET. KEY CHALLENGE 5 

HERE IS HOW DO WE CLOSE THE GHG GAP IN A SUSTAINABLE AND 6 

EQUITABLE MANNER? NEXT SLIDE LASTLY LET'S TALK ABOUT THE 7 

ECONOMY AND I WANT TO ACKNOWLEDGE THAT THE ECONOMY HAS CHANGED 8 

QUITE A BIT SINCE THE DRAFT BLUEPRINT STRATEGIES WERE 9 

DEVELOPED. FIRST OF ALL JOBS HOUSING BALANCE. ARE WE SEEING 10 

IMPROVEMENTS THERE AS A RESULT OF THE DRAFT BLUEPRINT IT 11 

DEPENDS ON THE COUNTY AND THE PART OF THE REGION WE ARE SEEING 12 

CLUSTERING OF HIGH INCOME JOBS IN SILICON VALLEY EVEN THOUGH 13 

WORKERS MIGHT NOT GO TO THE JOB SITE EVERY DAY THEY MAY BE 14 

TELEWORKING. HOUSING RICH COMMUNITIES IN EACH BAY AND NORTH 15 

BAY STILL SEE MORE LIMITED JOB GROWTH SO IT'S REALLY 16 

ACHIEVEMENT OF SOME OF THE JOBS HOUSING BALANCE ISSUES BY 17 

MOVING HOUSING TO THE JOB AS OPPOSED TO THE OPPOSITE. THE BAY 18 

AREA THRIVE IN THE FUTURE AGAIN THE ANSWER IS YES ESPECIALLY 19 

SINCE SELECT STRATEGIES ARE EXPECTING TO SEE ROBUST GROWTH. 20 

STRATEGIES AND INVESTMENTS INCLUDED IN THE DRAFT BLUEPRINT ARE 21 

NOT FORECASTED TO DRAG DOWN THE REGION'S ECONOMY IN FACT THEY 22 

HELP SUPPORT IT IN THE YEARS AHEAD AND THE ADDITIONAL TAX 23 

MEASURES APPLIED TO HIGHER NUMBER RESIDENTS AND BUSINESSES 24 

ENABLE THOSE TO GAINS OF THE REGIONAL ECONOMY ARE EQUITABLY 25 
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SHARED BY LOW INCOME RESIDENTS, FOR EXAMPLE, CHILD CARE 1 

STRATEGIES ARE REINVESTMENT IN LOW INCOME FAMILIES. KEY 2 

CHALLENGE FOR THE VIBRANCE PART OF THE PLAN HOW CAN MORE 3 

AMBITIOUS STRATEGIES BE EMPLOYED TO BRING HOMES CLOSER TO THE 4 

WORKFORCE? NEXT SLIDE. I KNOW WE HAVE COVERED A TON OF 5 

INFORMATION TODAY. BUT I WANT TO JUST SHOW THIS SLIDE BRIEFLY, 6 

AND QUEUE UP WHAT WE ANTICIPATE WILL BE A LIVELY DISCUSSION AT 7 

WORKSHOPS LATER THIS MONTH. I TALKED ABOUT A LOT OF THE 8 

CHALLENGES, AND WE CAN'T FOLLOW THEM ALL BUT WE HAVE DONE OUR 9 

BEST TO IDENTIFY THE FIVE BIGGEST CHALLENGES THAT HAVE NOT 10 

BEEN FULLY ADDRESSED AND THOSE ARE THE FIVE ISSUES I SHARED 11 

AND INCLUDE THE IN THE PREVIOUS SLIDE. WE WANT TO HEAR IDEAS 12 

FROM YOU. SO THIS SLIDE REFLECTS SOME DIFFERENT BRAINSTORMING 13 

IDEAS, SAYING, YOU KNOW, FROM INVESTMENT IN HIGH RESOURCE 14 

AREAS, OR NEW STRATEGIES RELATED TO RAIL AND BUS, WORKFORCE 15 

TRAINING PROGRAMS, TELECOMMUTING MANDATES, OFFICE DEVELOPMENT 16 

CAPS AND THE LIKE. ALL OF WHICH COULD BE EMPLOYED IN THE FINAL 17 

BLUEPRINT IF WE WANT TO MAKE HEADWAY ON SOME OF THESE KEY 18 

CHALLENGES. AT THE WORKSHOPS LATER THIS MONTH, OUR 19 

STAKEHOLDERS AS WELL AS THE PUBLIC, WE WILL BE LOOKING FOR 20 

YOUR IDEAS ON STRATEGY REVISIONS OR NEW STRATEGIES TO HELP 21 

ADDRESS THESE CHALLENGES. NEXT SLIDE. OF COURSE, AS WE 22 

IDENTIFY REVISIONS, IT'S ESSENTIAL THAT WE KEEP LISTENING TO 23 

LOCAL RESIDENTS, ESPECIALLY THOSE IN COMMUNITIES OF CONCERN. 24 

WE HAVE ALREADY STARTED THIS BY DOING COMMUNITY-BASED 25 
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ORGANIZATION FOCUS GROUPS ON THE DRAFT BLUEPRINT. THESE ARE 1 

REALLY MEANINGFUL IF YOU THINK ABOUT THE SORT OF STRATEGY 2 

REVISIONS WE SHOULD MAKE IN THE FINAL BLUEPRINT TO MAKE SURE 3 

THAT WE'RE ADDRESSING THE NEEDS OF RESIDENTS AND WHAT THEY'RE 4 

ACTUALLY TELLING US FROM OUR AFFORDABLE HOUSING STRATEGIES TO 5 

HOW YOU BRING INFRASTRUCTURE IN WAYS THAT DOESN'T CAUSE 6 

DISPLACEMENT OR REDESIGNING I TRANSIT SYSTEM FOR THOSE WHO ARE 7 

TRANSIT DEPENDENT THOSE ARE VIEWS THAT WE CAN CONTINUE TO WORK 8 

TO ADDRESS AS PART OF THE FINAL BLUEPRINT STRATEGY. NEXT 9 

SLIDE. FOURTH AND FINAL PART OF THE LENGTHY PRESENTATION ON 10 

THE DRAFT BLUEPRINT WHICH IS NEXT STEPS AND THIS IS WHERE YOU 11 

COME INTO THE PICTURE. WE WANT YOUR INPUT ON HOW TO ADDRESS 12 

SOME OF THESE CHALLENGES. NEXT SLIDE. THERE ARE A LOT OF 13 

OPPORTUNITIES FOR YOU TO GET ENGAGED AND TO GIVE US FEEDBACK. 14 

WE RECOGNIZE THE FIRST INFORMATIONAL PRESENTATION IS JUST THE 15 

TIP OF THE ICEBERG AND THAT FUTURE MEETINGS WILL HAVE 16 

OPPORTUNITY TO DIG IN EVEN FURTHER AND LISTEN TO YOUR 17 

FEEDBACK. HERE IS SOME WAYS THAT THE PUBLIC AS WELL AS YOU AS 18 

STAKEHOLDERS CAN GET ENGAGED WE'RE DOING NINE COUNTY PUBLIC 19 

WORKSHOPS AND 5 TELEPHONE TOWN HALLS IN MULTIPLE LANGUAGES 20 

WE'LL BE HAVING THREE STAKEHOLDER WORKSHOPS ONE ON THE ON 21 

ENVIRONMENT, ONE ON HOUSING AND ECONOMY AND THIRD ON EQUITY 22 

THAT WILL BE SIMILAR IN NATURE TO THOSE THAT WE DID AS PART OF 23 

THE DRAFT BLUEPRINT DEVELOPMENT PROCESS HERE AT 375 BEALE 24 

STREET. WITH THESE WORKSHOPS UNLIKE THOSE FOR THE DRAFT 25 
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BLUEPRINT WILL BE HELD VIRTUALLY SO WE'LL HAVE BREAK OUT ROOMS 1 

FOR SMALLER CONVERSATIONS. OTHER WAYS TO ENGAGE, WE WILL HAVE 2 

OFFICE HOURS FOR LOCAL JURISDICTION AND OTHER STAKEHOLDERS 3 

WHERE YOU CAN SIGN UP ON PLANNEDBAYAREA.ORG WEB SITE FOR 4 

FLYERS AND LISTENING LINE WHERE YOU CAN LEAVE VOICE MAIL 5 

FEEDBACK ON THE DRAFT BLUEPRINT AND PROVIDE ADDITIONAL 6 

COMMENTS THROUGH THE AUGUST 10TH PUBLIC COMMENT PERIOD. LASTLY 7 

WE'RE DOING A POLL ON ALL OF THE STRATEGIES IN THE DRAFT 8 

BLUEPRINT SO WE CAN USE THAT TO CONTINUE TO REFINE THINGS FOR 9 

THE FINAL BLUEPRINT PHASE. LOTS OF WAYS TO GET ENGAGED OVER 10 

THE NEXT MONTH WE HOPE YOU WILL JOIN US FOR THE NEXT WORKSHOPS 11 

WE HAVE FOR THE PUBLIC AND STAKEHOLDER EVENTS. NEXT SLIDE. AS 12 

WE LOOK FOR INPUT, I WANT TO UNDERSCORE WHAT WE'RE LOOKING FOR 13 

HERE. IF YOU GO TO THE BLUEPRINT WEB SITE, ON 14 

PLANNEDBAYAREA.ORG, YOU CAN SEE BOTH THE INPUTS, THE 15 

STRATEGIES AND THE OUTPUTS, THE OUTCOMES THAT DEAL WITH THOSE 16 

STRATEGIES. WE WANT TO HEAR YOUR FEEDBACK ON ALL OF THAT. SO 17 

MOST IMPORTANT IS HOW DO WE CHANGE THE STRATEGY TO GET US 18 

CLOSER TO SOME OF THE OUTCOMES THAT WE ALL DESIRE AND HOW DO 19 

WE ADDRESS SOME OF THE KEY CHALLENGES IN THE PROCESS? SO AS 20 

STAKEHOLDERS WE HOPE YOU WILL GIVE US FEEDBACK ON STRATEGIES 21 

TO ADD, MODIFY, OR REMOVE TO GET US TO THOSE GOALS. WHILE 22 

CONTINUING TO ADVANCE EQUITY AND RESILIENCE AND MOVE TOWARDS 23 

THE PLAN VISION. WE HAVE ALREADY STARTED THE PROCESS FOR 24 

TRANSPORTATION, WORKING TO REFINE PROJECTS AND PERFORMANCE 25 
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CHALLENGES AND BUNDLE THEM INTO ADDITIONAL STRATEGIES FOR THE 1 

FINAL BLUEPRINT BUT THERE IS MUCH MORE WORK AHEAD OVER THE 2 

NEXT TO TWO MONTHS OF THE ELEMENT OF THE BLUEPRINT. NEXT 3 

SLIDE. GREAT. THANK YOU. SO, JUST -- OH, IF YOU COULD GO BACK. 4 

THANKS. SO WHAT'S NEXT IN THE PROCESS? AS I MENTIONED, THIS 5 

MARKS THE RELEASE AND COMPLETION OF THE DRAFT BLUEPRINT PHASE 6 

WE'LL NOW BE SPENDING TIME IN VIRTUAL WORKSHOPS AND ENGAGEMENT 7 

OVER THE NEXT MONTH AND A HALF. AUGUST 10TH IS THE CLOSE OF 8 

THE BLUEPRINT PERIOD AND WE'LL BRED TO BOARD IN SEPTEMBER THAT 9 

WILL BE OPPORTUNITY TO SHARE WHAT WE HAVE HEARD FROM BAY AREA 10 

RESIDENTS, FROM STAKEHOLDERS WITH THE ELECTED OFFICIALS. AFTER 11 

THAT ACTIONS ON THE FINAL BLUEPRINT STRATEGY AND GEOGRAPHY 12 

GROWTH STRATEGIES WE WILL DO ANOTHER ROUND OF MODELING 13 

ANALYSIS AND RELEASE THE FINAL BLUEPRINT NO DECEMBER AND AT 14 

THAT TIME REQUEST MTC AND ABAG FEEDBACK FOR FINAL PHASES OF 15 

THE PLANNED BAY AREA 2050 PROCESS. DOING THE ENVIRONMENTAL 16 

WORK AND CREATING THE FINAL PLANNED DOCUMENT. NEXT SLIDE. SO 17 

THANK YOU FOR YOUR PATIENCE AS WE WENT THROUGH THIS LENGTHY 18 

PRESENTATION ON THE DRAFT BLUEPRINT. I THINK AT THIS POINT 19 

WE'RE GOING TO OPEN IT UP TO QUESTIONS OR COMMENTS YOU MIGHT 20 

HAVE. I ENCOURAGE YOU TO TAKE A LOOK AT ALL THE DETAILED 21 

MATERIAL ON THE STRATEGIES AND THE OUTCOMES FOR THE DRAFT 22 

BLUEPRINT, AND INVITE YOU ALL TO JOIN FOR OUR STAKEHOLDER 23 

WORKSHOPS WHERE WE WILL GET A CHANCE TO DIVE INTO THE CONTENT 24 

IN DETAIL.  25 



               July 7, 2020 

 27 

 1 

SPEAKER: OKAY. THANK YOU DAVE. SO IF YOU HAVE A QUESTION 2 

PLEASE TYPE IT INTO THE WINDOW. WE DO HAVE A FEW QUESTIONS 3 

READY. ALSO IF YOU HAVE A LENGTHIER COMMENT PLEASE SEND IT TO 4 

INFO AT PLANNEDBAYAREA.ORG AND THE COMMENT PERIOD ENDS AUGUST 5 

10TH. SO THE FIRST QUESTION IS A CLARIFICATION QUESTION. WHAT 6 

IS A HIGH RESOURCE AREA? DAVE, YOU'RE ON MUTE.  7 

 8 

DAVE VAUTIN: THANK YOU. HIGH RESOURCE AREA IDENTIFIED BY THE 9 

STATE OF CALIFORNIA AS A PLAY WITH WELL RESOURCED SCHOOLS, 10 

PARKS, JOBS, THERE ARE A NUMBER OF THESE COMMUNITIES IN THE 11 

BAY AREA THAT HAVE BEEN OFTEN EXCLUSIONARY. PLANNED BAY AREA 12 

ENCOURAGING MORE GROWTH IN THOSE PLACES THROUGH CONSTRUCTION 13 

OF NEW HOMES AS WELL AS ADDITIONAL DEVELOPMENT.  14 

 15 

SPEAKER: NEXT QUESTION WHY IS SOUTH BAY SEEING HIGH GROWTH NO 16 

HOUSING?  17 

 18 

DAVE VAUTIN: THAT'S A GREAT QUESTION. SOMETHING WE HAVE BEEN 19 

FOCUSED ON TRYING TO UNDERSTAND. SHORT ANSWER, ONE IS THE 20 

SOUTH BAY HAS A VERY SPECIFIC TYPE OF EXISTING DEVELOPMENT. 21 

THERE IS A LOT MORE LAND AVAILABLE THERE THAN IN PLACES LIKE 22 

SAN FRANCISCO AND OAKLAND THAT WERE DEVELOPED IN PREVIOUSLY, 23 

THE PARCEL SIZES ARE OFTEN LARGER WHICH MAKES THOSE AREAS MORE 24 

RIPE FOR REDEVELOPMENT. A LOT OF THE DEVELOPMENT WAS BUILT 25 
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SIGNIFICANT MID-20th CENTURY ERA, A LOT OF AGING STRIP MALLS 1 

AND OFFICE PARKS, AGAIN, THESE ARE AREAS THAT REALLY ARE 2 

PRIMED FOR NEW DEVELOPMENT IF THEY'RE ENABLED BY LOCAL, 3 

REGIONAL AND STATE ACTION. BUT AS WE ANALYZE THE DRAFT 4 

BLUEPRINT WHAT WE FOUND IS OUR STRATEGIES REALLY ENABLE 5 

ADDITIONAL GROWTH POTENTIAL IN THOSE LOCATIONS THAT ARE CLOSE 6 

TO SOME OF OUR, REALLY OUR LARGEST JOB CENTERS, SILICON 7 

VALLEY. OF COURSE WE'RE INTERESTED IN HEARING YOUR FEEDBACK ON 8 

WHETHER WE SHOULD ADJUST OUR STRATEGIES TO INCLUDE GROWTH IN 9 

OTHER PARTS OF THE REGION. THAT'S WHAT WE'RE SEEING AT THIS 10 

POINT IS A LOT OF GROWTH POTENTIAL DOWN IN THE SOUTH BAY AND 11 

SOME OF THE KEY BENEFITS FROM IT.  12 

 13 

SPEAKER: NEXT QUESTION. DID I READ THE LAST CHART CORRECTLY 14 

THAT THE NEW DRAFT BLUEPRINT ANTICIPATES AN EVEN LOWER SHARE 15 

OF JOB GROWTH FOR CONTRA COSTA COUNTY? IT IS NOT AIMING TO 16 

INCREASE JOBS IN THE MORE SUBURBAN AREAS?  17 

 18 

DAVE VAUTIN: SO WE INCLUDED SOME STRATEGIES TO TRY TO 19 

ENCOURAGE MORE JOBS IN HOUSING RICH AREAS. ULTIMATELY THOSE 20 

STRATEGIES DID NOT PROVE SIGNIFICANT ENOUGH TO ACHIEVE A LOT 21 

OF GAIN. ONE NOTABLE EXCEPTION TO THAT, WAS SOME ADDITIONAL 22 

GROWTH IN SOUTHERN ALAMEDA COUNTY, LIKE FREMONT, FOR EXAMPLE, 23 

WHERE WE SAW A LITTLE BIT OF SKILL OVER JOB GROWTH ENCOURAGED 24 

BY THE JOBS HOUSING AND OTHER STRATEGIES ON THE ECONOMIC SIDE. 25 
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BUT ULTIMATELY JOBS LIKE TO CLUSTER WITH OTHER JOBS SO EVEN AS 1 

MORE PEOPLE ARE TELECOMMUTING WE WERE SEEING GAINS IN TERMS OF 2 

JOBS IN THOSE EXISTING JOB CENTERS INCLUDING SILICON VALLEY. 3 

ULTIMATELY IT WILL BE UP TO HEARING FEEDBACK FROM YOU AND OUR 4 

BOARDS WHETHER WE CONSIDER MORE ROBUST STRATEGIES TO TRY TO 5 

FORCE THOSE JOBS TO DIFFERENT PARTS OF THE REGION, TO AVOID 6 

THAT CLUSTERING EFFECT.  7 

 8 

SPEAKER: GREAT. NEXT QUICKLY. GHG PROJECTIONS SHOULD EVALUATE 9 

ACCELERATED EV ADOPTION SCENARIOS WHY ASSOCIATE PUBLIC TRANSIT 10 

WITH AUTO? ARE YOU PROPOSING ALL ELECTRIC VEHICLES AS A FORM 11 

OF PUBLIC TRANSIT?  12 

 13 

DAVE VAUTIN: LET ME TRY TO BREAK THAT INTO TWO PARTS. FIRST OF 14 

ALL LOOKING AT THE GREENHOUSE GAS EMISSIONS DATA FOR PLAN 15 

2050, THE NUMBERS THAT WE'RE SHOWING BASICALLY DO NOT ACCOUNT 16 

FOR THE SOURCE OF EFFICIENCY IMPROVEMENTS THAT OCCUR ON THE 17 

STATE AND FEDERAL LEVEL WE'RE PRECLUDED FROM COUNTING THOSE 18 

UNDER THE CARB REGULATION. WE'RE PREDICTING WHAT THE REGION'S 19 

LOCAL AGENCIES MIGHT PROVIDE WE HAVE INCLUDED ADDITIONAL 20 

ELECTRIFICATION OF AUTOMOBILE FLEET AS PART OF OUR CLIMATE 21 

INITIATIVE STRATEGY IN DEVELOPMENT OF THE PLAN BUT WE ARE OPEN 22 

TO SUGGESTION IN TERMS OF WHETHER THERE SHOULD BE EXPANDED 23 

REGIONAL SUBSIDIES FOR EVS TO AUGMENT THE FEDERAL AND STATE 24 

ACTION. JUST TO IMPORTANT CAVEAT HERE, THE REASON FOR THE 25 
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STATE REQUIREMENTS NOT ACCOUNTING FOR THOSE THINGS IS THEY 1 

DON'T WANT US TO DOUBLE COUNT THE EFFECTS. THEY WANT TO ENSURE 2 

WHEN WE'RE TALKING ABOUT REDUCING GHG EMISSIONS BY NINE 3 

PERCENT THAT'S INCLUDING STRATEGIES ON THE REGIONAL AND LOCAL 4 

LEVEL.  5 

 6 

SPEAKER: NEXT QUESTION DOES THIS PLAN ASSUME THAT ALL PUBLIC 7 

TRANSPORTATION IS VEHICLES WILL BE REDUCED BY 2040 WHAT 8 

PERCENT OF TRUCKS WILL BE 0-EMISSIONS?  9 

 10 

DAVE VAUTIN: WE HAVE THE CLEAN FLEET IN PLACE FOR PUBLIC 11 

TRANSPORTATION SO YES THE SYSTEM IS NOT EMITTING THE SAME 12 

SORTS OF LEVELS AS IT IS TODAY HOWEVER I WOULD NOTE THAT 13 

AGAIN, THE STATE TARGET DOES NOT INCLUDE TRUCKS OR BUSES. IT'S 14 

JUST ABOUT CARS AND LIGHT DUTY TRUCKS. SO THAT'S REALLY 15 

IMPORTANT. URSULA, COULD YOU READ THE SECOND PART OF THE 16 

QUESTION?  17 

 18 

SPEAKER: SURE. WHAT PERCENTAGE OF TRUCKS WOULD BE 0-EMISSIONS?  19 

 20 

DAVE VAUTIN: THAT IS A GOOD QUESTION. WE ARE JUST ASSUMING 21 

THAT BECAUSE THAT'S OUTSIDE OF THE JURISDICTION OF THE 22 

GREENHOUSE GAS TARGET SET, THAT STATE REGULATION DICTATES THE 23 

FUTURE OF FLEET METRICS FOR TRUCKS.  24 

 25 
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SPEAKER: OKAY. GREAT. NEXT QUESTION. FINDINGS AND CHALLENGES 1 

RELATED TO A MORE DIVERSE BAY AREA SEEM TIED TO AFFORDABLE 2 

HOUSING LOOKING AT INCOME OF HOUSEHOLD IN DIFFERENT GEOGRAPHY 3 

LIKE HIGH RESOURCE AREAS IS THERE FUTURE DATA THAT MTC IS 4 

USING TO ACCESS RACIAL DIVERSITY IN THE SAME GEOGRAPHIES IN 5 

ADDITION INCOME?  6 

 7 

DAVE VAUTIN: THAT IS A GREAT QUESTION. OUR STRATEGIES ARE 8 

DESIGNED TO INCREASE RACIAL DIVERSITY IN THESE HIGH RESOURCE 9 

AREAS, HOWEVER, ALL MODELS HAVE CONSTRAINTS AND ONE OF THE 10 

CONSTRAINTS OF OUR MODELS IS THAT WE DO LOOK AT DIFFERENT 11 

TYPES OF HOUSEHOLDS BROKEN DOWN BY INCOME LEVELS BUT MOST 12 

OTHER REGIONS IN THE COUNTRY, WE DO NOT FORECAST RACIAL 13 

DEMOGRAPHICS ON THE LOCALIZED LEVEL. THAT MAKES IT A LITTLE 14 

BIT DIFFICULT FOR US TO UNDERSTAND THE FUTURE RACIAL 15 

DEMOGRAPHICS. WHILE WE SEE IMPROVEMENT IN TERMS OF SHARE OF 16 

LOWER INCOME HOUSEHOLDS IN THESE PLACES THAT TELLS US THAT AT 17 

LEAST FROM AN INCOME PURPOSE WHICH IS OFTEN TIED TO RACIAL 18 

DEMOGRAPHICS PERSPECTIVE THAT WE ARE MAKING THESE PLACES MORE 19 

DIVERSE. IT'S NOT JUST A, YOU KNOW, A PREDOMINANTLY HIGH 20 

INCOME, PERHAPS PREDOMINANTLY WHITE PLACE THAT IT'S BECOME 21 

MORE DIVERSE.  22 

 23 

SPEAKER: WE HAVE A COUPLE OF COMMENTS, AND I THINK WE MAY BE 24 

AT THE END. ONE COMMENT IMPORTANT TO NOTE THAT WHILE IT IS 25 
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FREE GOVERNMENT TO REQUIRE MORE DEED RESTRICTED AFFORDABLE 1 

HOUSING IT IS ADMINISTRATIVELY EXPENSIVE TO MONITOR ON AN 2 

ANNUAL BASIS ONGOING DEVELOPER -- [INDISCERNIBLE] FRONT LOADED 3 

-- 20 PLUS YEAR PERIOD. THAT'S ONE COMMENT. AND THEN ANOTHER 4 

COMMENT, TRANSIT AGENCIES ARE UNDER CARB REQUIREMENTS TO HAVE 5 

0-EMISSIONS FLEETS BY 2040. SO THAT -- IS  6 

 7 

DAVE VAUTIN: OKAY.  8 

 9 

SPEAKER: ANYONE ELSE?  10 

 11 

CLERK OF THE BOARD: THERE IS A MEMBER OF THE PUBLIC WITH THEIR 12 

HANDS RAISED.  13 

 14 

URSULA VOGLER: OKAY.  15 

 16 

CLERK OF THE BOARD: FIRST UP IS CINDY WINTER. GO AHEAD AND 17 

UNMUTE YOURSELF CINDY.  18 

 19 

SPEAKER: THANK YOU MARTHA. I HAD A COMMENT, BUT I'M GOING TO 20 

SEND IT IN WRITING, BECAUSE IT'S FAIRLY DETAILED AND 21 

TECHNICAL. SO I'LL SEND IT TO URSULA VOGLER AT THE SITE THAT 22 

SHE JUST TOLD US ABOUT ON INFO PLANNEDBAYAREA.ORG. THAT'S MY 23 

COMMENT FOR THIS MOMENT. THANK YOU.  24 

 25 
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CLERK OF THE BOARD: OKAY. NEXT UP WE HAVE RICH HEDGES. RICH, 1 

GO AHEAD AND UNMUTE YOURSELF.  2 

 3 

RICHARD HEDGES: HI DAVE, CAN YOU HEAR ME?  4 

 5 

CLERK OF THE BOARD: WE CAN HEAR YOU. GO AHEAD.  6 

 7 

RICHARD HEDGES: DAVE, ONE OF THE QUESTIONS I'VE ALWAYS HAD 8 

ABOUT MOVING JOBS TO MORE HOUSING RICH AREAS, FOR INSTANCE, 9 

THE MORE SUBURBAN MARKETS IN THE EAST, I ASSUME THAT'S WHAT 10 

WE'RE TALKING ABOUT, IS IT SORT OF PLAYING WHACK A MOLE WHEN 11 

YOU START MOVING LARGE NUMBER OF JOBS YOU START RAISING THE 12 

ISSUE OF RISING RENTS IN THOSE AREAS DON'T WE JUST KEEP MOVING 13 

PEOPLE AROUND SEARCHING FOR LOWER AND LOWER RENTS FARTHER AND 14 

FARTHER AWAY FROM WHERE WE HAVE CONCENTRATION OF JOBS? SEEMS 15 

TO BE THE ANSWER WOULD MORE LIKELY BE TO BUILD AS MUCH HOUSING 16 

AS POSSIBLE THROUGHOUT THE BAY AREA INCLUDING IN JOB RICH 17 

AREAS. THANK YOU.  18 

 19 

CLERK OF THE BOARD: OKAY. AND LASTLY, WE HAVE ALETA DUPREE. GO 20 

AHEAD ALETA, UNMUTE YOURSELF.  21 

 22 

SPEAKER: THANK YOU. GOOD MORNING COMMITTEE. ALETA DUPREE FOR 23 

THE RECORD. AS I DIGEST THIS PRESENTATION, I'M SURE I'LL BE 24 

REPLAYING IT. I THINK WE ARE GOING TO BE LOOKING AT SOME NEW 25 
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NORMALCY THAT REALLY WEREN'T FORECAST BEFORE. AND I THINK 1 

PROBABLY THE BIG ELEPHANT IN THE ROOM RIGHT NOW IS THE 2 

POTENTIAL FOR TELECOMMUTING. AND I HAVE ALWAYS SUPPORTED 3 

TELECOMMUTING, AND ONE WAY THAT WE CAN MAKE A COMMUNITY MORE 4 

AFFORDABLE IS IT IF A PERSON DOESN'T HAVE TO SPEND AS MUCH ON 5 

TRANSPORTATION. ESPECIALLY IF THEY HAVE TO RIDE MULTIPLE 6 

SYSTEMS. AND NOW TELECOMMUTING OF COURSE CAN REALLY CHANGE THE 7 

GAME BECAUSE NOW IF A PERSON DOESN'T HAVE TO REPORT TO WORK 8 

THEY CAN BASICALLY WORK FROM ANYWHERE IN THE WORLD WHERE THEY 9 

CAN HAVE AN INTERNET CONNECTION SO THINK ABOUT MOVING TO 10 

NEVADA WHERE THERE IS NO STATE INCOME TAX. SO THESE ARE THINGS 11 

THAT WE SHOULD BE MINDFUL OF. I DON'T THINK IT HAS TO BE AT 12 

THE EXPENSE OF PUBLIC TRANSPORTATION. BUT CERTAINLY I THINK 13 

THERE ARE TOO MANY CARS ON THE ROAD AND CARS SHOULD BE 14 

ELECTRIC ANYWAY. SO LET'S SEE WHAT WE CAN DO WITH NEW NORMALS. 15 

THANK YOU.  16 

 17 

CLERK OF THE BOARD: THANK YOU ALETA. THAT WAS THE LAST 18 

ATTENDEE WITH THEIR HAND RAISED.  19 

 20 

URSULA VOGLER: LAST COMMENT: I AM THINKING AMAZON TRUCKS ARE 21 

IN THE LIGHT TRUCK CATEGORY. COULD REQUIRING THEM TO BECOME 22 

ZERO-EMISSION BE A STRATEGY FOR REDUCING GHG EMISSIONS? DAVE, 23 

WE CAN'T HEAR YOU.  24 

 25 
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DAVE VAUTIN: THANK YOU. REQUIRING DELIVERY TRUCKS COULD BE 1 

IMPORTANT IN THE CLIMATE STRATEGY HOWEVER AMAZON TRUCKS ARE IN 2 

THE MEDIUM DUTY CATEGORY WHICH OUR STRATEGY WOULDN'T COUNT IN 3 

CLOSING THE GREENHOUSE GAS. LIGHT DUTY TRUCKS ARE PICK UP 4 

TRUCKS, FOR EXAMPLE. ALL RIGHT. I THINK -- I GUESS WE HAVE 5 

MADE OUR WAY THROUGH ALL OF THE QUESTIONS THERE. ONE LAST 6 

REMARK AND THEN I'M GOING TO TURN IT OVER TO RALLY FOR OUR 7 

NEXT ITEM ON TRANSPORTATION IN THE FINAL DRAFT BLUEPRINT. WE 8 

HAVE SENT OUT INVITES FOR THE UPCOMING STAKEHOLDER WORKSHOPS 9 

IN LATE JULY AND EARLY AUGUST. HOPEFULLY YOU WILL HAVE TIME TO 10 

SOAK IN THE ANALYSIS THAT'S BEEN COMPLETED HERE AND JOIN US 11 

FOR THAT DISCUSSION. WE ARE E ARE GAR TO GET YOUR FEEDBACK ON 12 

WHAT'S WORKING AND NOT WORKING IN THE DRAFT BLUEPRINT IS HOW 13 

WE TACKLE THE HEFTY CHALLENGES OVER THE SUMMER. THANK YOU. I 14 

WILL NOW TURN IT OVER TO RALEIGH, AND ADAM ON THE 15 

TRANSPORTATION ELEMENT.  16 

 17 

RALEIGH MCCOY: THANK YOU DAVE. IF WE COULD QUEUE UP THE SLIDE 18 

DECK. THANK YOU. GOOD MORNING EVERYONE MY NAME IS RALEIGH 19 

McCOY. WITH THE PLANNING SECTION OF MTC AND ABAG I WILL BE 20 

PROVIDING A PRESENTATION THAT WE'LL BE TAKING TO JOINT MTC AND 21 

ABAG PLANNING COMMITTEES THIS WEEK ON PROVIDING STAFF PROPOSAL 22 

FOR THE DRAFT BLUEPRINT. LAST MONTH WE SHOWED A PREVIEW OF 23 

FUNDING FOR A HANDFUL OF PROJECTS THIS MONTH WE CONTINUE TO 24 

MOVE FORWARD FOR PROPOSAL OF THE FINAL BLUEPRINT WE'LL BE 25 
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SHOWING UPDATE ON THE PROJECTS THAT WILL BE RECOMMENDED TO 1 

RECEIVE REGIONAL FUNDING ADDITIONALLY IN THIS PRESENTATION 2 

WE'LL BE HIGHLIGHTING KEY INFORMATION PRIMARILY THE SEQUENCING 3 

OF WHEN REGIONAL FUNDS WILL BE RECOMMENDED TO BE ASSIGNED TO 4 

THE REGIONAL PROJECTS AS WELL AS INFORMATION ON THE REGIONAL 5 

MAGNITUDE ON RECOMMENDED FUNDING FOR THE PROJECTS IN THE NEXT 6 

WEEKS WE'LL BE TAKING THIS INFORMATION TO STAFF AT COUNTY 7 

TRANSPORTATION AGENCIES AS THEY FINALIZE FISCALLY CONSTRAINED 8 

PROJECT LIST WITH PROJECT LISTS IN TURN FEEDING BACK INTO THE 9 

PROPOSAL FOR THE TRANSPORTATION ELEMENT OF THE FINAL 10 

BLUEPRINT. NEXT SLIDE PLEASE. BRIEFLY RECAP WHERE WE HAVE BEEN 11 

OVER THE COURSE OF THE PROCESS. IDENTIFICATION OF WHICH 12 

PROJECTS WERE COMPETITIVE WERE IDENTIFIED IN 2019 WHEN AROUND 13 

100 MAJOR PROJECTS WERE SUBMITTED FOR ANALYSIS FOR THE 14 

ASSESSMENT PROCESS. EVALUATED ON COST EFFECTIVENESS EQUITY AND 15 

ALIGNMENT WITH PLANNED BAY AREA 2050 GUIDELINES AND 16 

PRINCIPLES. TEN WERE IDENTIFIED AS A RESULT OF THE ANALYSIS. 17 

REMAINING 90 PROJECTS ANALYSIS IDENTIFIED AREAS WHERE PROJECTS 18 

FELL SHORT AND IDENTIFIED PROJECTS THAT COULD BE INCLUDED IN 19 

PROJECT MODIFICATION OR COMPLIMENTARY STRATEGIES SPONSORS WERE 20 

ABLE TO LEVERAGE TO INCLUDE PROJECT PERFORMANCE THROUGH THE 21 

COMMIT LETTER PROCESS WITH THE COMMITMENT LETTERS BEING 22 

RECEIVED IN APRIL OF THIS YEAR. NEXT MAJOR DELIVERABLE WAS THE 23 

DRAFT COUNTY PROCESS RECEIVED IN MARCH FOR CTAS IDENTIFIED BY 24 

PROJECTS BASED ON REVENUE AVAILABLE. INCLUDED PROJECTS 25 
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EVALUATED IN THE PROJECT ASSESSMENT ALONG WITH PROJECTS IN 1 

PROBLEMATIC AREAS. INSUFFICIENT OF COST FOR PROGRAM GAPS MAY 2 

BE FILLED BY USING REVENUE SOURCE OUTSIDE OF THE COUNTY'S 3 

CONTROL REFERRED TO AS REGIONAL DISCRETIONARY REVENUES IN THE 4 

PLANNING CONTEXT. BASED ON PERFORMANCE THE COMMITMENT LETTERS 5 

WERE APPLICABLE AND THE AMOUNT OF REGIONAL FUNDING AVAILABLE 6 

STAFF AT MTC AND ABAG HAVE PREPARED AN INITIALLY 7 

RECOMMENDATION FOR FUNDING WE'LL PRESENT TO THE COMMITTEE THIS 8 

IS WEEK AND FULL SET OF RECOMMENDATIONS ARE IN ATTACHMENT B OF 9 

YOUR PACKET WHERE YOU WILL SEE INFORMATION ARE FOR THE 10 

PROJECTS IN TERMS OF THE MAGNITUDE OF REGIONAL FUNDING 11 

RECOMMENDED AS WELL AS AGAIN THE SEQUENCING. JUST TO BRIEFLY 12 

HIGH LIGHT NEXT STEPS FOR PARTNERS ARE WE HAVE INITIATED THE 13 

PROCESS OF MEETING WITH EVERYONE ONE-ON-ONE TO GO OVER THE 14 

FISCALLY CONSTRAINED PROJECT LIST AND WE'RE ASKING CTAS RETURN 15 

THOSE TO US BY THE END OF JULY AND ADDITIONALLY WE'RE ASKING 16 

FOR BOARD ACTION ON COMMITMENT LETTERS BY THE END OF AUGUST. 17 

NEXT SLIDE PLEASE. AS I REFERENCED ON THE PREVIOUS SLIDE PER 18 

GUIDANCE FROM THE CALIFORNIA AIR RESOURCES BOARD THE FINAL 19 

BLUEPRINT OF PLANNED BAY AREA 2050 THE TRANSPORTATION ELEMENT 20 

OF THAT IS SPLIT INTO TWO TIME PERIODS 2021 TO 2035 AND 2036 21 

TO 2050 EFFORT TO CLOSELY ALIGN PROJECTED INVESTMENTS WITH 22 

PROJECTED REVENUES WILL BE AVAILABLE. AS WE SHARED IN JUNE 23 

REVENUES IN THE FIRST HALF OF THE PLAN ARE SUBSTANTIALLY 24 

LIMITED COMPARED TO REVENUES IN THE SECOND HALF DUE TO A 25 
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NUMBER OF FACTORS INCLUDING A REDUCTION IN NEAR TERM REVENUES 1 

DUE DOWNRIGHT ECONOMIC RECESSION. AS WELL AS NEW RETCH NEWS IN 2 

THE LATTER HALF OF THE PLAN. GIVEN THE NATURE OF THE REVENUES 3 

IN PERIOD ONE RECOMMENDATIONS PRIORITIZE PROJECTS THAT ADVANCE 4 

EQUITY AND WILL HELP CONTRIBUTE TOWARD OUR SB 375 GREENHOUSE 5 

GAS EMISSIONS REDUCTION GOALS PERIOD TWO MORE CAPACITY 6 

AVAILABLE THERE ARE A NUMBER OF HIGHER COST TRANSIT AND ROAD 7 

PROJECTS RECOMMENDED. RECOGNIZING OF COURSE THESE ARE REGIONAL 8 

PRIORITIES DUE TO THE FISCAL REALITIES OF THE FUNDS AVAILABLE 9 

THESE PROJECTS ARE RECOMMENDED FOR THE SECOND HALF OF THE 10 

PLAN. WE HAVE RECEIVED QUESTIONS ON WHAT THE IMPLICATIONS OF A 11 

PROJECT BEING IN THE SECOND HALF OF THE PLAN ARE JUST TO 12 

PROVIDE MORE CONTEXT THERE PROJECTS THAT ARE INCLUDED IN THE 13 

SECOND HALF OF THE PLAN ARE STILL INCLUDED IN PLANNED BAY AREA 14 

2050 WHICH MEANS THEY CAN MOVE FORWARD WITH PROJECT 15 

DEVELOPMENT AND ENVIRONMENTAL WORK. AND REALLY THE PRIMARY 16 

IMPLICATION OF A PROJECT BEING LISTED WITH AN OPEN YEAR IN 17 

PERIOD TWO IMPLEMENTATION WILL BE IMPACTED IF THEY WOULD LIKE 18 

TO BE IMPLEMENTED IN THE FIRST YEARS OF THE PLAN REQUIRING 19 

ADMINISTRATIVE ACTION TO ADDRESS THE OPEN YEAR OF THE PLAN. 20 

HOWEVER UNDERSTANDING OF COURSE THAT SITUATIONS MAY -- 21 

CIRCUMSTANCES MAY CHANGER FOR A PROJECT AND FUNDING MAY BECOME 22 

AVAILABLE MTC AND ABAG STAFF WILL PLAN TO DEVELOP A SYSTEMIC 23 

PROCESS TO GUIDE PROJECTS THROUGH THAT PROCESS MOVING FROM 24 

PERIOD TWO TO PERIOD ONE AND THIS IS SOMETHING THAT WOULD BE 25 
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DEVELOPED IN THE YEAR 2021. NEXT SLIDE. MOVING INTO THE 1 

PROPOSAL NOW, THE RECOMMENDATIONS FOR THE TRANSPORTATION 2 

ELEMENT OF PLANNED BAY AREA 2050 FINAL BLUEPRINT TOTAL 3 

INVESTMENT OF AROUND $550 BILLION ACROSS THE PERIOD 140 4 

BILLION OF THAT CONSIDERED REGIONAL DISCRETIONARY AND 5 

REMAINDER -- TRANSPORTATION SYSTEM CONSUMES OVER TWO THIRDS OF 6 

THE INVESTMENT IN THE PLAN REMAINING REVENUES DIRECTED TOWARDS 7 

STRATEGIES INCLUDE INVESTMENTS THAT EXPAND OUR ROAD NETWORKS 8 

AS WELL AS INVESTMENT IN POLICY BASED STRATEGIES THAT REDUCE 9 

TRANSIT FARE COST OR PRICE FREEWAY DRIVING FOR EXAMPLE, IN 10 

LOOKING NOW AT THE REGIONAL DISCRETIONARY INVESTMENTS IN THE 11 

CHART AT THE BOTTOM RIGHT UNDER HALF OF ALL REGIONAL 12 

DISCRETIONARY REVENUES IN THE PLAN ARE RECOMMENDED FOR 13 

INVESTMENT WITH TRANSIT PROJECTS IN ALIGNMENT WITH EQUITY 14 

GOALS. FUNDING SIMULTANEOUSLY ASSIGNMENTS ARE OPERATIONAL COST 15 

USING TO FUND THE SYSTEMS THAT WE MAINTAIN TODAY ROAD 16 

INVESTMENTS SHOWN IN YELLOW ACCOUNT FOR 50 PERCENT OF ALL 17 

REGIONAL DISCRETIONARY INVESTMENT. NEXT SLIDE. IN THE NEXT TWO 18 

SLIDES I'LL HIGHLIGHT SOME EARLY FINDINGS FROM ANALYSIS 19 

CONDUCTED IN ACCORDANCE WITH TITLE SIX REGULATIONS. FIRST 20 

THING TO HIGHLIGHT HERE AS I SAID ON THE PREVIOUS SLIDE TWO 21 

THIRDS OF ALL TRANSPORTATION INVESTMENTS ARE DIRECTED TOWARDS 22 

MAINTAINING OUR EXISTING SYSTEM THE CHART TOP LEFT SHOWS 23 

INVESTMENTS IN EXISTING TRANSIT SYSTEM BENEFIT MINORITY 24 

RESIDENTS OVER WHITE RESIDENTS BASED ON THE DEMOGRAPHIC 25 
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PROFILE OF TODAY'S TRANSIT USERS. THIS LAYS AN EQUITABLE 1 

FOUNDATION FOR THE BLUEPRINT. BOTTOM LEFT SHOWS TRANSPORTATION 2 

STRATEGIES ASIDE FROM OPERATING OUR EXISTING SYSTEM BENEFIT 3 

MINORITY OR WHITE RESIDENTS AND WE CAN SEE THAT INVESTING IN 4 

ROAD PROJECTS USED TOWARD BENEFITTING WHITE USERS WHILE 5 

INVESTING IN TRANSIT RESULTS IN AN EVEN SPLIT. NEXT SLIDE. 6 

FOCUSING NOW ON TRANSIT STRATEGIES OUTSIDE OF JUST MAINTAINING 7 

OUR EXISTING SYSTEM BUT LAYERING ON TOP OF THAT THE APPROACH 8 

TO CRAFTING THE FINAL BLUEPRINT WAS TO PRIORITIZE PROJECTS IN 9 

THE 15 YEARS OF THE PLAN INCLUDING NUMBER OF INVESTMENT IN 10 

BART AND BUS SERVICE. CHART ON THE LEFT USER INCOME AND RACE 11 

BROKEN UP BY TIME PERIOD SHOWN BROKEN UP EVEN IN THE FIRST 15 12 

YEARS OF THE PLAN. THIS UNDER SCORES THE NEED FOR MORE 13 

STRATEGIC ACTION TO ADVANCE EQUITY GOALS INCLUDING ADVANCE 14 

STRATEGIES FOR MEANS-BASED OR TRANSIT FARES TO REDUCE COST OF 15 

TAKING TRANSIT. NEXT SLIDE. FOR THE SECOND HALF OF THIS 16 

PRESENTATION I'LL BE DIVING INTO MORE DETAIL ON THE REVISED 17 

REGIONAL DISCRETIONARY FUNDING MEMORIAL MECHANISMS FOR THE 18 

TRANSPORTATION ELEMENT. NEXT SLIDE. AND THE NEXT COUPLE OF 19 

SLIDES ARE ORGANIZED HIGHLIGHTING EXAMPLE KEY PROJECTS 20 

RECOMMENDED FOR REGIONAL FUNDING FOR EACH OF THE FOUR 21 

TRANSPORTATION STRATEGIES HIGHLIGHTED ON THE SCREEN AND AGAIN 22 

WE'LL BE PROVIDING MORE INFORMATION ON THE RECOMMENDATIONS BY 23 

TIME PERIOD. I WANT TO DIRECT YOU ALL TO ATTACHMENT B WITH THE 24 

FULL SET OF RECOMMENDATIONS ARE INCLUDED AND HIGHLIGHTED. 25 
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THESE ARE JUST A FEW EXAMPLE PROJECTS THAT WE'LL BE GOING OVER 1 

TODAY. NEXT SLIDE. BEFORE I GET STARTED, AS DAVE HIGHLIGHTED 2 

IN THE PREVIOUS PRESENTATION, ANALYSIS OF A MORE LIMITED SET 3 

OF TRANSPORTATION INVESTMENT IN THE DRAFT BLUEPRINT SHOWED 4 

THAT PER CAPITA GREENHOUSE GAS EMISSIONS REDUCTIONS FELL SHORT 5 

OF THE SB 375 MANDATED TARGET BY AT LEAST SEVEN PERCENTAGE 6 

POINT GAP. WHILE THE FINAL BLUEPRINT INCLUDES A NUMBER OF 7 

INVESTMENTS IN TRANSIT THAT MAY HELP CLOSE THE GAP IT INCLUDES 8 

EXPANDED ROADWAY CAPACITY WHICH COULD MOVE THE NEEDLE IN 9 

OPPOSITE DIRECTION BY INCENTIVIZING MORE DRIVING. 10 

RECOMMENDATIONS SHARED IN THE UPCOMING SLIDES MAY NEED TO BE 11 

REVISITED BASED ON GREENHOUSE GAS EMISSIONS PERFORMANCE. STAFF 12 

HAS BEGUN THE PROCESS OF NEGOTIATING SPONSORS OF ROAD CAPACITY 13 

PROJECTS IN RESPONSE TO GREENHOUSE GAS EMISSIONS MITIGATION 14 

MEASURES. NEXT SLIDE. WHILE A NUMBER OF SMALLER INTERCHANGE 15 

AND HIGHWAY IMPROVEMENTS ARE FULLY FUNDED THROUGH COUNTY 16 

BUDGET FUNDS, SEVERAL LARGER SCALE PROJECTS WITH REGIONAL 17 

IMPACTS ARE SCHEDULED TO RECEIVE REGIONAL FUNDING. IN THE 18 

FIRST 15 YEARS OF THE PLAN THAT INCLUDES IMPROVEMENTS ON SR37 19 

CORRIDOR OPTIMIZATION OF FREEWAY NETWORK AND INVESTMENTS ON 20 

SR4 AND SR239 CORRIDORS. LATTER HALF OF THE PLAN REGIONAL 21 

FUNDS ARE RECOMMENDED TOWARDS SR37 FINAL PROJECT FOR FINISHING 22 

THE 868012 INTERCHANGE IMPROVEMENT PROCESS AND IMPROVEMENTS ON 23 

SR262. A NUMBER OF SMALLER INVESTMENTS ARE ALSO INCLUDED FOR 24 

RECOMMENDATION IN THE FINAL BLUEPRINT. INCLUDING I880 25 
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WESTBOUND TRUCK SCALES A IMPROVEMENTS AT -- JUNCTION IN NAPA. 1 

REFERENCED ON THE PREVIOUS SLIDE PROJECTS THAT INCREASE 2 

ROADWAY CAPACITY SHOWN HERE WITH AN ASTERISK IN THE BOXES ARE 3 

RECOMMENDED FOR FINAL INCLUSION WITH ADDITIONAL GREENHOUSE GAS 4 

EMISSIONS MITIGATION MEASURES. NEXT SLIDE. THE STRATEGY TO 5 

ENHANCE LOCAL FREE CAPACITY INVESTMENT IN PERIOD ONE TO 6 

ADVANCE PROGRESS TOWARDS CLIMATE AND EQUITY GOALS INCLUDED IN 7 

THE STRATEGY ARE A NUMBER OF IMPROVEMENTS TO BUS SERVICE 8 

THROUGHOUT THE REGION INCLUDING NETWORK INVESTMENTS FOR AC 9 

TRANSIT, MUNI AND SONOMA COUNTY, ALL SMALLER INVESTMENTS 10 

SIGNAL PRIORITY, IMPROVEMENTS TO BUS STOPS AND SMALLER SCALE 11 

FREQUENCY BOOST TO LOCAL NETWORKS. NEXT SLIDE. INVESTMENT IN 12 

THIS STRATEGY SEEK TO MODERNIZE AND EXTEND THE REGIONAL RAIL 13 

NETWORK THE STRATEGY INCLUDES SEVERAL INVESTMENT IN THE BART 14 

SYSTEM, CORE CAPACITY TO SILICON VALLEY AND DUMBARTON 15 

INCLUDING RAIL INVESTMENT IN THE SECOND HALF OF THE PLAN 16 

INCLUDING TRANSBAY RAIL CROSSING OAKLAND AND SAN FRANCISCO AND 17 

A NUMBER OF PROJECTS THAT FEED INTO SUPPORTING THE INVESTMENT 18 

INCLUDING FREQUENCY INCREASES ON CALTRAIN EXTENSION AND VALLEY 19 

LINK PROVIDING A CONNECTION BETWEEN SAN JOAQUIN VALLEY AND THE 20 

REST OF THE BAY AREA. ADDITIONALLY SEVERAL LIGHT RAIL PROJECTS 21 

IN THE STRATEGY FOR INVESTMENTS AREAS SUCH AS GRADE 22 

SEPARATIONS OR GENERAL STATION ENHANCEMENT. NEXT SLIDE. 23 

FINALLY CONTINUING TO THE REGION'S FREEWAY NETWORK THE 24 

STRATEGY ENVISIONS NEXT GENERATION FREEWAY NETWORK FOR 25 



               July 7, 2020 

 43 

CARPOOLERS. REGIONAL EXPRESS LANES NETWORK WITH INVESTMENTS 1 

DIRECTED TO THE FIRST HALF OF THE PLAN. SEVERAL EXPRESS BUS 2 

ROUTES WOULD OPERATE LIMITED EXPRESS BUS LANES NETWORK FROM 3 

DIRIDON STATION TO TRANSIT CENTER IN SAN FRANCISCO TO VALLEJO 4 

TO SF AIRPORT VIA SAN FRANCISCO AND TO OAKLAND AND DUMBARTON 5 

BRIDGE. ON THE CORRIDORS I 680 EAST BAY TRANSIT LINE TO 6 

SUPPLEMENT INVESTMENTS NOTING HERE THE ASTERISK WITH THE 7 

REGIONAL EXPRESS LANES NETWORK WIDENING PROJECTS HERE ARE 8 

RECOMMENDED INTENTIONAL ON GREENHOUSE GAS EMISSIONS 9 

RECOMMENDATIONS. NEXT SLIDE. RECOMMENDATIONS PRESENTED HERE 10 

TODAY WILL HELP INFORM THE DEFINITION OF SEVERAL 11 

TRANSPORTATION STRATEGIES IN THE FINAL BLUEPRINT HOWEVER THE 12 

STRATEGIES IN QUESTION ARE ONE COMPONENT OF ONE ELEMENT OF THE 13 

FINAL BLUEPRINT AND STAFF ARE CURRENTLY AT WORK PREPARING FOR 14 

THE NEXT ROUND OF PUBLIC ENGAGEMENT ON THE FINAL BLUEPRINT TO 15 

HELP FURTHER INFORM THE DEFINITION FOR STRATEGIES FOR 16 

TRANSPORTATION, HOUSING, THE ECONOMY AND THE ENVIRONMENT IN 17 

ORDER TO FINALIZE THE PROPOSAL SO WE CAN BEGIN ANALYSIS. TO 18 

TOUCH ON OUTREACH IN THE COVID ERA STAFF AT MTC AND ABAG HAVE 19 

PUT TOGETHER ENGAGEMENT WITH ONLINE AND OFFLINE STARTING IN 20 

MID-JULY STAFF WILL HOST 15 DIGITAL PUBLIC WORKSHOPS 21 

COMPLIMENTED BY TOWN HALLS AND OPTIONS FOR ENGAGING WITH 22 

INTERNET ACCESS ADDITIONAL TOW ENGAGE THE REGION'S INDIGENOUS 23 

COMMUNITY WE'LL BE HOSTING A TRIBAL SUPPLEMENT -- SUMMIT. WE 24 

ARE HOSTING TWO EXTENDED WORKSHOPS AS WELL AS EXTENDED WORKING 25 
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GROUP WORKSHOP LATER THIS MONTH AND WE HOPE YOU ALL CAN 1 

PARTICIPATE. NEXT SLIDE. TO CLOSE OUT THE PRESENTATION, IN MAY 2 

MTC AND ABAG STAFF HELD FOCUS GROUPS FROM COMMUNITY-BASED 3 

ORGANIZATIONS SERVING GROUPS FROM DISADVANTAGED COMMUNITIES 4 

INCLUDING PEOPLE WITH DISABILITY IMMIGRANTS LOW INCOME PEOPLE 5 

AND WE WANT TO CLOSE THE PRESENTATION BY HIGHLIGHTING DIRECT 6 

QUOTES. COMMON THEMES THERE WAS A BROAD INTEREST IN ORIENTING 7 

INVESTMENTS TOWARDS THE TYPES OF TRIPS THAT LOW INCOME PEOPLE 8 

TAKE INCLUDING WEEKEND AND OFF PEAK COMMUTES. HIGHLIGHTING THE 9 

SHORTCOMINGS OF THE EXISTING SYSTEM INCLUDING BARRIERS TO 10 

ACCESSING DISCOUNT PROGRAMS AND TRANSFERS BETWEEN SYSTEMS. ONE 11 

QUOTE THAT'S SHOWN ON THE SCREEN SUMS IT UP BEST. THIS PERSON 12 

SAID I JUST WANT THE BUS TO BE NEW, CLEAN, AND NOT BREAK DOWN. 13 

AS WE CONTINUE TO THINK THROUGH THE PROPOSAL FOR THE FINAL 14 

BLUEPRINT OVER THE COMING MONTHS INFO LIKE THIS WILL BE 15 

CRITICAL TO PROPOSE AND ADVANCE EQUITY AND MEET THE NEEDS OF 16 

THE MARGINALIZED COMMUNITIES. TO WRAP UP, FOR RECOMMENDATIONS 17 

TODAY MILESTONES COMING UP ON THE SLIDE ENGAGEMENT IN JULY AND 18 

INTEND TO RETURN IN SEPTEMBER TO SHARE THE PROPOSAL. AND WITH 19 

THAT MY COLLEAGUES AND I CAN TAKE ANY QUESTIONS.  20 

 21 

URSULA VOGLER: OKAY. THANKS RALEIGH. IF YOU HAVE A QUESTION, 22 

PLEASE TYPE IT IN THE CHAT OR RAISE YOUR HAND AND MARTHA CALL 23 

ON YOU. FIRST QUESTION. OUT OF THE FIRST 90 PROJECTS THAT FELL 24 
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SHORT, HOW MANY ADVANCED INTO FINAL STRATEGIES AND HOW MANY 1 

WERE EXCLUDED?  2 

 3 

RALEIGH MCCOY: THAT IS A GOOD QUESTION. I CAN GET BACK TO YOU 4 

WITH AN EXACT NUMBER BUT OFF THE TOP OF MY HEAD, I WOULD GUESS 5 

AROUND 2O OR SO BUT WE CAN FOLLOW UP WITH AN EXACT NUMBER.  6 

 7 

URSULA VOGLER: OKAY. NEXT QUESTION. CAN YOU ELABORATE ON WHAT 8 

NEW TRANSBAY RAIL CROSSING PHASE ONE CONSISTS OF AND WHY IT 9 

HAS TO WAIT UNTIL 2O 35?  10 

 11 

RALEIGH MCCOY: I CAN START OFF AND I CAN ENCOURAGE ANY OF MY 12 

COLLEAGUES TO JUMP IN WITH ADDITIONAL INFORMATION. KEY 13 

HIGHLIGHT IS PHASE ONE REFERENCES THE FACT THAT EARLIER IN THE 14 

HORIZON PROCESS SEVERAL MORE EXPANSIVE TRANSBAY RAIL CROSSING 15 

DESIGNS WERE EVALUATED INCLUDING CROSSINGS THAT EXTENDED FROM 16 

OAKLAND TO SAN FRANCISCO AND SERVED MULTIPLE STOPS WITHIN SAN 17 

FRANCISCO FOR THE FINAL BLUEPRINT THE PHASE ONE JUST REFERS TO 18 

TRANSBAY RAIL CROSSING THAT LINKS OAKLAND WITH SAN FRANCISCO 19 

ACKNOWLEDGING THAT FUTURE EXTENSIONS MAY BE POSSIBLE. AND WHY 20 

IT COULDN'T -- WHY IT HAS TO WAIT UNTIL 2035. AFTER 2035 21 

REPRESENTS THE OPEN YEAR NOT NECESSARILY THE START OF 22 

CONSTRUCTION YEAR AND GIVEN THE FACT THAT THIS PROJECT IS SO 23 

LARGE IN SCALE, HAVING IT OPEN BEFORE 2035 IS HIGHLY UNLIKELY 24 

GIVEN THE CONSTRUCTION PERIOD.  25 
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 1 

DAVE VAUTIN: I'LL HIGHLIGHT SOMETHING RALLY MENTIONED, THE 2 

FINAL BLUEPRINT PROPOSAL WE'RE SHARING TODAY FOR 3 

TRANSPORTATION INCLUDES CATEGORIES FOR FUNDS IN LOWER COST FOR 4 

THE CORE CAPACITY STUDY WE SEE THINGS LIKE INVESTMENT IN BUS 5 

SERVICE OR IMPROVEMENT OF THE DIRECT LINE WE'RE PROPOSING FOR 6 

INCLUSION IN THE FIRST HALF OF THE PLAN FOR VALLEJO AND SAN 7 

FRANCISCO THOSE INVESTMENTS CAN HELP ADDRESS THE CAPACITY 8 

RATES IN THE SHORT AND MEDIUM TERM, OF THE CROSSING PROJECT 9 

PROVES MORE NECESSARY AS WE GET TOWARDS 2050 AND THE DEMAND IN 10 

THAT CORRIDOR EXCEEDS THE CAPACITY WITH TRADITIONAL LOWER COST 11 

INVESTMENTS SO THAT'S WHY THAT PROJECT WHICH PROVE PRETTY COST 12 

EFFECTIVE IN THE PROJECT PERFORMANCE ASSESSMENT IS RECOMMENDED 13 

FOR INCLUSION BUT IN THE SECOND HALF OF THE PLAN.  14 

 15 

URSULA VOGLER: AS A FOLLOW UP TO THAT WOULD YOU CONSIDER 16 

INCLUDING TRANSBAY TO ONE AS YOU RECEIVE A MORE COST EFFECTIVE 17 

PROPOSAL?  18 

 19 

DAVE VAUTIN: I THINK WHAT I WILL SAY IS THIS IS MUCH BROADER 20 

THAN THE CROSSING PROJECT. THERE IS MUCH MORE FISCALLY 21 

CONSTRAINED ENVIRONMENT IN THE FIRST HALF OF THE PLAN. IN THE 22 

SECOND HALF OF THE PLAN, WE HAVE FUNDING MEASURES LIKE A 23 

POTENTIAL TRANSPORTATION MEGA MEASURE THAT CAN HELP FUND A LOT 24 

OF THE VERY ASPIRATIONAL RAIL PROJECTS THAT HAVE BEEN PROPOSED 25 
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IN THE REGION AND THE CROSSING IS JUST ONE. THERE ARE OTHER 1 

TYPES THAT ARE CONSIDERED IN THE SECOND HALF OF THE PLAN SO 2 

GIVEN THE CONSTRAINED FUNDING IN THE FIRST HALF THE 3 

RECOMMENDATION THAT STAFF IS PREPARED HERE REALLY TRIES TO 4 

CHANNEL THAT MORE LIMITED INVESTMENT INTO THE MOST COST 5 

EFFECTIVE PROJECTS. THOSE TEND TO BE BUS RAPID TRANSIT LINES 6 

TARGETED EXPRESS BUS MOVEMENTS FERRY LINES THOSE SORT OF 7 

PROJECTS FORM THE TOP PRIORITIES FOR THE FIRST HALF OF THE 8 

PLAN.  9 

 10 

URSULA VOGLER: NEXT QUESTION REGARDING VALLEY LINK ISN'T THAT 11 

A FACILITATION OF INTER-REGIONAL COMMUTING?  12 

 13 

DAVE VAUTIN: I'LL TAKE THIS ONE AS WELL. THANKS FOR BRINGING 14 

UP THAT POINT. SB 375 SAYS THAT WE NEED TO MAKE SURE THAT WE 15 

PLAN FOR ALL THE REGIONAL HOUSING GROWTH SO IF IT DOES NOT 16 

GROW IN THE FUTURE. THAT DOESN'T MEAN THERE AREN'T TENS OF 17 

HUNDREDS OF THOUSANDS OF FOLKS WHO ARE DOING THOSE COMMUTES 18 

TODAY, COMMUTES THAT COULD CURRENTLY HAVE ONE VIABLE OPTION BY 19 

CAR SO FOR THAT REASON GIVEN THERE ARE SIGNIFICANT NUMBERS OF 20 

FOLKS DRIVING OVER ALTAMONT PASS, AND PERFORMANCE IN PROJECT, 21 

WE ARE INCLUDING OPTION TO CONNECT TO BART AND TO ENABLE THEM 22 

TO TAKE TRANSIT TO THEIR DESTINATION.  23 

 24 
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URSULA VOGLER: NEXT QUESTION. CAN YOU PROVIDE ADDITIONAL 1 

DETAILS ABOUT WHAT IT MEANS TO BE IN PERIOD TWO FOR MAJOR 2 

PROJECTS? CAN THESE PROJECTS SEEK FUNDING IN ADVANCE OF PERIOD 3 

TWO DURING PERIOD ONE? WOULD A PERIOD TWO PROJECT'S ABILITY TO 4 

SEEK FUNDING BE DEPENDENT ON THE FORTHCOMING MEGA PROJECT 5 

FUNDING POLICY?  6 

 7 

RALEIGH MCCOY: PERIOD TWO REFERS TO THE OPENING YEAR OF THE 8 

PROJECT. PROJECT DEVELOPMENT ACTIVITIES COULD OCCUR PRIOR TO 9 

THAT IN PERIOD ONE INCLUDING BEGINNING TO LOOK FOR FUNDING AND 10 

MY COLLEAGUES CAN CORRECT ME IF THAT ISN'T. YEAH. WOULD A 11 

PERIOD TWO PROJECT ABLE TO SEEK -- NO IT WOULD NOT BE 12 

DEPENDENT ON THE MEGA PROJECT.  13 

 14 

DAVE VAUTIN: I'LL ADD TO WHAT RALLY JUST SAID WHEN WE TALK 15 

ABOUT THE MEGA PROJECT ADVANCEMENT POLICY A LOT OF PROJECTS WE 16 

CAN'T AFFORD IN THE FIRST HALF OF THE PLAN WITHOUT DISPLACING 17 

KEY LOW COST PERFORMING PROJECTS LIKE BUS RAPID TRANSIT LINES. 18 

PROJECTS PROPOSED FOR DEVELOPMENT IN 2021 WOULD ENABLE A 19 

PROJECT THAT'S GOING TO AMEND THE PLAN OR MOVE THOSE PROJECTS 20 

FORWARD IN THE FIRST HALF OF THE PLAN IF CIRCUMSTANCES CHANGE 21 

IF THE PERFORMANCE HAVE BEEN ADDRESSED AND NEW COST EFFECTIVE 22 

MEASURES TO INTRODUCE THE HIGH COST OF THE PROJECT ARE 23 

INCORPORATED OR IF NEW REVENUES BECOME AVAILABLE EARLIER THAN 24 

EXPECTED. IF A MEGA MEASURE PASS IN 2O 22 THAT WOULD BE A 25 
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DIFFERENT GAME DEPENDING ON REVENUES AVAILABLE IN THE FIRST 1 

HALF OF THE PLAN. THAT POLICY WOULD ALLOW US TO STRATEGICALLY 2 

ADVANCE PROJECTS IN BIN ONE WITH JUSTIFICATION OBVIOUSLY IF 3 

THAT MERITS THAT ADVANCEMENT.  4 

 5 

URSULA VOGLER: THIS IS THE FINAL WRITTEN QUESTION. CAN MTC 6 

BEGIN DEVELOPMENT OF THE MEGA PROJECT ADVANCEMENT POLICY 7 

BEFORE 2021 SO THAT IT CAN BE FINALIZED EARLY IN 2021 AND USED 8 

FOR POLICY DECISION MAKING IN 2050.  9 

 10 

DAVE VAUTIN: PLANNED BAY AREA 2050 IS READY FOR ADOPTION IN 11 

2021 IF WE BEGIN WORKING ON THAT EFFORT EARLIER IN THE YEAR 12 

THAT WOULD BE SOMETHING WE'RE THINKING As WE'RE FINALIZING THE 13 

IMPLEMENTATION PLAN AND THE FINAL DOCUMENTS.  14 

 15 

URSULA VOGLER: OKAY. I DON'T SEE ANY HANDS RAISED MARTHA.  16 

 17 

CLERK OF THE BOARD: NO HANDS ARE RAISED AND PEOPLE ARE 18 

REMINDED TO PRESS STAR NINE OR USE THE RAISED HAND FEATURE IF 19 

THEY WOULD RATHER TALK THAN TYPE.  20 

 21 

URSULA VOGLER: THERE'S A HAND.  22 

 23 

CLERK OF THE BOARD: GO AHEAD ALETA AND UNMUTE YOURSELF.  24 

 25 
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SPEAKER: THANK YOU COMMITTEE. ALETA DUPREE FOR THE RECORD. 1 

GOOD PRESENTATION. IT'S VERY IMPORTANT THAT WE LOOK FORWARD. I 2 

CERTAINLY THINK THAT WE SHOULD BE MORE TRANSIT ORIENTED AS 3 

OPPOSED TO HIGHWAY ORIENTED. I'M NOT A PARTICULARLY BIG FAN OF 4 

HIGHWAY AND HIGHWAY AND EXPANSION, HOWEVER THE HIGHWAYS NEED 5 

TO BE KEPT IN STATE OF GOOD REPAIR. I DO SUPPORT THE IDEA OF 6 

EXPRESS BUS ROUTES, AND TOLLING ON EXPRESS LANES, AND PRICING, 7 

THEY BENEFIT ME AS A BUS RIDER BEING ABLE TO GO ACROSS THE BAY 8 

BRIDGE USING BYPASS. CERTAINLY I LIKE TO SEE WHAT A NEW RAIL 9 

CROSSING UNDER THE BAY WOULD LOOK LIKE ESPECIALLY GIVEN THAT 10 

BART HAS A UNIQUE TRACK GAUGE THAT'S GENERALLY USED IN INDIA 11 

SO WE WOULD HAVE TO SEE THE COMPATIBILITY OF RUNNING TRAINS ON 12 

DIFFERENT TRACK GAGES UNDER THAT TUNNEL IT WOULD BE 13 

CHALLENGING. CONNECTIVITY IS IMPORTANT BECAUSE WE HAVE TO 14 

CONSIDER NEW YORK HAS MANY, MANY RAIL TUNNELS SOME OVER ONE 15 

HUNDRED YEARS AGO. AND GATEWAY, GOING UNDER HUDSON RIVER, 16 

LET'S STAY PROACTIVE OF THIS SO WE CAN MEET IT WHEN THE TIME 17 

ARISES. THANK YOU.  18 

 19 

CLERK OF THE BOARD: THAT'S IT NO ONE ELSE WITH THEIR HAND 20 

RAISED.  21 

 22 

URSULA VOGLER: OKAY. I THINK WE'RE READY FOR THE NEXT ITEM.  23 

 24 
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MARK SHORETT: THANKS URSULA. I'M GOING TO TALK ABOUT THE 1 

REGIONAL PRIORITY DEVELOPMENT AREAS. AND YOU CAN REFER TO YOUR 2 

COMMITTEE PACKET FOR THE MEMO. THIS MONTH WE'LL BE GOING TO 3 

THE ABAG EXECUTIVE BOARD FOR THE ADOPTION OF FOUR NEW PRIORITY 4 

DEVELOPMENT AREAS, AND AS A LITTLE BIT OF CONTEXT MANY OF YOU 5 

WILL RECALL THAT IN FEBRUARY OF THIS YEAR, 34 NEW PDAS WERE 6 

ADOPTED AND 48 MODIFIED PDAS WERE ADOPTED ALL INCLUDED IN THE 7 

DRAFT PLANNED BAY AREA 2050 BLUEPRINT WHICH YOU HEARD ABOUT 8 

EARLIER CONSISTENT WITH THE REVISED REGIONAL GROWTH FRAMEWORK 9 

UPDATED PDA MATERIAL ADOPTED BY THE BOARD LAST SPRING 10 

FOLLOWING ADOPTION OF THE NEW AND MODIFIED PDAS IN EARLY 11 

FEBRUARY OF THIS YEAR, WE DECIDED THAT IT MADE SENSE TO 12 

PROVIDE AN OPPORTUNITY AND THIS WAS SOMETHING THE EXECUTIVE 13 

BOARD DIRECTOR HAS TO DO AS WELL IS ADDITIONAL SUBMISSIONS FOR 14 

NEW PDAS AND MODIFIED PDAS THAT WOULD BE INCLUDED IN THE FINAL 15 

PLANNED BAY AREA 2050 BLUEPRINT. SO THIS PERIOD RECENTLY 16 

CONCLUDED, AND DURING THIS PERIOD, WE RECEIVED FOUR 17 

SUBMISSIONS FOR NEW PRIORITY DEVELOPMENT AREAS, AS WELL AS 18 

FIVE MODIFIED PRIORITY DEVELOPMENT AREAS. SO THIS FOLLOWED 19 

ENGAGEMENT THROUGHOUT THE REGION ENSURING THAT EVERYONE WAS 20 

AWARE OF THE OPPORTUNITY TO DO THIS, SEEING IF ANY CITIES 21 

WANTED TO MAKE ADDITIONAL TWEAKS, AND VERY QUICKLY THE FOUR 22 

NEW PDAS ALL OF WHICH WERE SUPPORTED BY COUNCIL ADOPTED 23 

RESOLUTIONS, INCLUDE TWO IN THE CITY OF SAN RAFAEL, ONE IN 24 

FAIRFIELD AND ONE IN THE CITY OF BENICIA TWO AROUND RAIL 25 
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STATIONS AND WE HOPE IT ADVANCES SOME OF THE KEY OBJECTIVES OF 1 

THE OVERALL PLAN FOR THE REGIONAL GROWTH FRAMEWORK. WE 2 

RECEIVED FIVE MODIFIED DEVELOPMENT AREAS EXPANDING BOUNDARIES 3 

OF EXISTING PRIORITY DEVELOPMENT AREAS AND KEY HIGHLIGHT 4 

THERE, ONE OF THOSE SUBMISSIONS FROM THE CITY OF LIVERMORE 5 

WHICH WAS OF THE SOUTH FRONT PDA WHICH WOULD SORT OF LEVERAGE 6 

THE NEW VALLEY LINK STATION PROPOSED FOR THAT AREA AS WELL AS 7 

THE BASK OWE A STATION. ALL THOSE RESPECTS VALUES ALLOWED THE 8 

CITY OF LIVERMORE TO BE IN A SUPPOSITION OF WHERE 50 PERCENT 9 

OF PDA AVAILABLE AREA BE NOMINATED. THAT'S A KEY PIECE WHAT IT 10 

DOES IN THE FINAL BLUEPRINT IS ALLOW THE CITY TO DEFINE ALL OF 11 

THE AREAS THAT ARE GOING TO BE STUDIED FOR POTENTIALLY HIGHER 12 

LEVELS OF GROWTH. SO, AGAIN, THAT'S SOMETHING THAT'S GOING TO 13 

GO TO THE ABAG EXECUTIVE BOARD THIS MONTH -- WELCOME TO ANSWER 14 

ANY QUESTIONS.  15 

 16 

URSULA VOGLER: OKAY. ANY COMMENTS, PLEASE TYPE THEM IN THE 17 

CHAT BOX FOR MARK OR RAISE YOUR HAND AND MARTHA CAN CALL ON 18 

YOU. OKAY. I GUESS WE'LL GIVE IT A FEW SECONDS.  19 

 20 

CLERK OF THE BOARD: AGAIN, PRESS STAR NINE OR USE THE RAISE 21 

HAND FEATURE.  22 

 23 

URSULA VOGLER: OKAY. WELL, THANK YOU MARK, I'LL TURN IT OVER 24 

TO MATT. OH HERE WE GO. HERE'S A QUESTION. WOULD YOU CONSIDER 25 
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A $50 MILLION PROJECT TO CONNECT SMART TO FERRY. I THINK THIS 1 

IS FROM THE PREVIOUS PRESENTATION.  2 

 3 

DAVE VAUTIN: I CAN TAKE THIS ONE IT'S NOT EXACTLY RELATED TO 4 

THE ITEM WE'RE TALKING ABOUT RIGHT NOW BUT WE DID SOLICIT 5 

PROJECT IDEA THROUGH THE TRANSFORMATIVE PROJECTS PROCESS AS 6 

WELL AS THE PROJECT PROCESS IN 2018 AND 2019 THAT WAS 7 

SOMETHING WE DID EARLIER IN THE PLANNING PROCESS FOR HORIZON. 8 

IN THIS WE HAVE PROJECTS WE'RE EXPLORING WE'RE NOT INTRODUCING 9 

NOW PROJECTS AT THIS LATE STAGE IN THE PROCESS.  10 

 11 

URSULA VOGLER: I'LL TURN IT OVER TO DAVE OR MATT TO CLOSE US 12 

OUT. THANK YOU.  13 

 14 

MATT MALONEY: WE'LL MOVE TO AGENDA ITEM FIVE, PUBLIC COMMENTS 15 

OR OTHER BUSINESS. ARE THERE ANY COMMENTS FROM STAKEHOLDERS OF 16 

MEMBERS OF THE PUBLIC IF YOU WISH TO MAKE COMMENT ON ANYTHING 17 

YOU CAN USE THE RAISED HAND FEATURE OR DIAL STAR NINE. HEARING 18 

NONE. WE'LL MOVE TO AGENDA ITEM SIX WHICH IS ADJOURNMENT AND 19 

OUR NEXT MEETING. SINCE WE ARE SCHEDULED TO HAVE A NEXT 20 

MEETING OF RAWG, IT SAYS HERE IN AUGUST, IS THAT TRUE DAVE? 21 

LET ME JUST ASK MY COLLEAGUE IF THAT'S TRUE. AUGUST 11TH.  22 

 23 

DAVE VAUTIN: NO. WE'RE NOT HAVING A RAWG MEETING IN AUGUST. I 24 

WANT TO THROW OUT THE DATES FOR FOLKS ON THE WORKSHOPS WHICH 25 
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RAWG ATTENDEES ARE INVITED TO JOIN FOR. SO WE'LL BE HAVING THE 1 

HOUSING AND ECONOMY WORKSHOP FOR THE FINAL BLUEPRINT ON JULY 2 

29TH, AND THEN THE TRANSPORTATION AND ENVIRONMENT WORKSHOP ON 3 

AUGUST 4TH.  4 

 5 

URSULA VOGLER: DAVE, WHEN IS THE EQUITY WORKING GROUP?  6 

 7 

DAVE VAUTIN: THE REGIONAL WORKING GROUP, AND THE EQUITY AND 8 

ACCESS MEETING IT'S ALSO THE WEEK OF JULY 11TH.  9 

 10 

CLERK OF THE BOARD: IT WILL BE HELD JULY 30TH, THE 11 

SUBCOMMITTEE EQUITY AND ACCESS WILL MEET AT 1:05 P.M.  12 

 13 

URSULA VOGLER: THANK YOU. OKAY. ARE WE CLOSING THIS OUT THEN? 14 

THANK YOU EVERYONE FOR PARTICIPATING. AND WE HOPE TO SEE YOU 15 

IN ONE OF OUR WORKSHOPS, AND STAY TUNED FOR THE SUPER RAWG. 16 

THERE WILL BE MORE INFORMATION SOON. THANK YOU. HAVE A NICE 17 

DAY. [ADJOURNED]  18 

 19 


